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Abstract

The purpose of this research is to explore the role of LIDAR Technology and Digital Fabrication techniques in 

the field of architectural conservation, particularly for the patching of ornamental heritage. The information is 

compiled in the form of a guide. Information gathered via the aid of experiments and subsequent observations is  

also recorded. These experiments were performed using various professional 3D scanning, digital fabrication, and 

traditional mold making techniques for the transference of geometry. The case recorded in detail is the patching of a 

mechanically damaged Belgian Blue Limestone column fragment. Another aspect of the research is to explore the use 

of various mesh generation and manipulation methods. This information can then be used by conservationists to aid 

in conservation efforts when traditional methods are either not sufficient or not feasible, thereby exploring the role of 

the ‘Neo-craftsperson’ in the digital age. To gather subjective insight on the topic, professional conservationists were 

also interviewed and all opinions are recorded. 
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One of the pressing epidemics of our 
time is the continual degradation of 
humanity’s built heritage, especially in 
inaccessible regions often affected by 
conflict (Hanna, Tawfeeq, & Mackay, 
2015). Built heritage is an extension of 
humanity’s collective cultural heritage 
(Tweed & Sutherland, 2007) and 
therefore has an inherent value that 
cannot be recreated irrespective of 
technological progress. Its value is 
derived from either historical context, 
chronological significance or the sheer 
quality of the craftsmanship. The 
ongoing conflict in Syria and the 
consequential destruction of Palmyra - a 
Neolithic city in the district of Tadmor - 
are an example of how built heritage is 
being systematically destroyed, often 
irreversibly (Hanna et al., 2015). The 
city developed its heritage over a period 
of centuries, and of course none of the 
original craftsmen survive, but there is 
yet some hope. 

A number of factors contributed to the 
initiation of this graduation project. 

1. INTRODUCTION

These include a research lacuna in the 
use of digital fabrication technology in 
the field of architectural conservation, 
particularly in the restoration of 
ornaments by replacing fragments 
(regeneration is well documented), a 
dearth of specialised craftsmen 
(Bourdieu, 2013) and restrictive 
craftsmanship labour costs, as well as a 
proliferation and popularization of 
digital fabrication techniques amongst 
the professional and general populations.  

Another more personal contributing 
factor is an imminent threat to Chauburji 
in the author’s hometown of Lahore. 
Chauburji is a 17th Century Mughal 
monument near the Walled City being 
threatened by infrastructure projects 
being carried out in its immediate 
vicinity by the provincial government 
against local conservation regulations. 
Such events confirm how fragile the state 
of humanity’s built heritage is and how 
quickly it can irreversibly disappear 
under certain circumstances. 

On October 2015, Creative Commons, 

a non-profit organization that provides 
an online repository of license-free 
creative content, started another 
repository called ‘New Palmyra’, which 
stores the 3D models of Palmyra 
generated by jailed activist Bassel 
Khartabil (Busta, 2015). The eventual 
goal of the repository is to digitally 
regenerate the entire city of Palmyra with 

Figure 1. Temple of Bel, Palmyra.  Source: James Gordon

Figure 2. Regenerated 3D model of Temple of 
Bel. Source: New Palmyra

Built Heritage, Palmyra, Craftsmen & The Digital Revolution

Figure 3. Impression of regenerated gate in 
London Source: Institute of Digital Archaeology

the help of the global community. An 
example from the repository is the 
Temple of Baalshamin, pictured in 
Figure 1, with the regenerated 3D model 
pictured in Figure 2. This event signifies 
one of the many ways in which 
technology is being bridged with the 
field of architectural conservation, a 
combination of the new with the old for 
the preservation of humanity’s heritage.

Another example that indicates the 
proliferation of this idea are the Institute 
of Digital Archaeology’s plans of building 
replicas of the entrance arch to the 
temple in Trafalgar Square, London and 
Times Square, New York City. The 
project therefore becomes both a venture 
into the age of the internet of things, as 
well as an act of resistance. An early 
representation of the project can be seen 
in Figure 3. In a similar vein, New York 
based Rhizome has created an online 
repository of stl and obj (3D file formats) 
files for the purposes of disseminating 
them amongst the public for 3D 
Printing. The artists describe the goal of 
the project in the following words, ‘...we 
see a call for artists and activists to 
imagine 3D printing as a radical, political 
tool for reshaping matter and its digital 
destiny.’ These events coupled with the 
convenience and personalization that 
Digital Fabrication technologies promise 
to provide are pushing it gradually 
towards mass adoption.

1.1 THE DIGITAL AGE                        
The aforementioned events are occurring 
at a time when the world is going 
through a digital revolution, a ‘third 
industrial revolution’ economy is on the 
brink of emergence. This relates to the 
fact that physical products are now not 
only limited to the physical realm but are 
also available digitally in the form of 
schematics that can be read by computers, 
which in turn can provide instructions to 
machines that can then manufacture the 
product. 

A more interventionist approach in 
which technology is used within the con-
servation community is through a com-
bination of 3D Scanning and Digital 
Fabrication. This collection of tech-
niques is gradually gaining popularity 
within the architectural conservation 
community, particularly in the use of 
CNC milling techniques for the recrea-
tion of relief elements. The prevalent 
modus operandi involve replacing entire 
elements by regenerating the craftsman-
ship using milling techniques. 

Other methods involve ‘repairing’ the 
most damaged parts of the elements by 

slicing the elements into multiple com-
ponents. These new ‘parts’ are often rep-
resentations of the original form of the 
design, with the smoothing caused by 
weather and other stimuli reversed, 
producing a stark contrast between the 
old and the new. A domestic iteration of 
such machines is in the field of additive 
manufacturing (amongst others), in the 
form of 3D Printers which are becoming 
increasingly prevalent, giving the 
consumer the ability to mass customize 
their goods. The project aims to not only 
make use of the digital realm but also 

combine it with appropriate technolo-
gies to help restore instances of built 
heritage. The digital realm can thus 
provide access to the collective expertise 
of the world’s restorers since it removes 
physical constraints. There is of course, 
rarely a universal solution for every case 
but rather specialized or hybridized 
solutions that are a result of adapting to 
the specificities and peculiarities of each 
case. These solutions can range from 
additive manufacturing to multi-axis 
milling or a hybridized form of both, 
depending on the parameters set by the 
constraints of the case. 

The energy saved at every step of the digital 
manufacturing process, from reduction in 
materials used, to less energy expended in 
making the product, when applied across 
the global economy, adds up to a qualitative 
increase in energy efficiency beyond anything 
imaginable in the First and Second Industrial 
Revolutions. - Jeremy Rifkin

Figure 4. Digitally Fabricated Restoration of Tympanum Maquette. Source: CIMS Lab

Figure 5. Digitally assisted stone carving. Source: CIMS Lab
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1.2 REDEFINING 
CRAFTSMANSHIP

American curator Richard F. Bach 
wrote a critique of craftsmanship for 
the American Magazine of Art in 1922 
which is as relevant today as it was at the 
time. 

Written immediately after the aftermath 
of the Second Industrial Revolution, in 
the article he argues against the perception 
that the increasing adoption of tools and 
machines for production were a threat to 
craftsmanship and would contribute to 
a lower quality of products in the long 
run. He criticizes a popular assumption 
that a craftsman should work primarily 
‘by hand’ perhaps with the aid of simple 
hand-held tools. He gives the example 
of a contemporary potter who would 
use motorized tools to expedite the 
job, something that takes nothing away 
from the quality of the product and the 
potters are no less craftsmen for trying 
to improve the craft that they inherited. 
He declares that craftsmanship, like all 
other things, improves by competition, 
so technologies like steam and electricity 
should not be barred. He suggests that 
instead of demonizing the machine and 
regarding it as an enemy of the hand, 
craftsmen, like modern manufacturers, 
should ‘profit from the resources of 
science and invention’ (which he suggests 
are part of the ideals of craftsmanship). 
He goes on to assert that “There is a 
craftsmanship of the machine, there is a 
craftsman feeling in the factory.” (Bach, 
1922)

The fundamental point that Bach was 
trying to make was that if craftsmen 
have conceded to using tools anyway, 
why stop there? Why should the scale 
and type of tool make a difference? 

Whilst Bach was talking about 
craftsmanship in the context of 
manufacturing and not architectural 
restoration, the principle remains the 
same: if the same end result can be 
achieved with minimal time and effort 
via the aid of technology, then traditional 
craftsmanship is reduced to a matter of 
mere sentiment. 

It can be postulated that in the context of 
the digital age, a person operating digital 
fabrication machinery or manipulating 
digital meshes on their computer could 
be considered a type of ‘neo-craftsman’ 
or ‘neo-craftsperson’. The fundamental 
principal being the same: the use of one’s 
hands to interact with a tool that aids in 
one’s craft. 

This redefinition of craftsmanship can 
be summarized as a triangle. The neo-
craftsman’s triangle consists of the three 
technological requirements that enable 
the physical realisation of digital designs. 

D
IG

IT
AL

 
FA

BR
IC

AT
IO

N

H
U

M
AN

 
IN

TERFAC
IN

G

COMPUTER AIDED DESIGN

In certain cases however, resorting 
to tradition can be an essential 
component of the authenticity of a 

project, depending upon the amount of 
sensitivity required  for the intervention. 
In the case of architectural restoration, 
the digital craftsman is only emulating 
the work of an earlier master, producing 
new projects directly with the aid of 
digital fabrication may not result in 
works with the same sensitivity that the 
human hand provides, although that is 
just mere conjecture. 

Nevertheless, traditional craftsmanship 
seems to be in decline, from reasons 
varying from cost of living to the 
proliferation of other more lucrative 
fields. This aspect is further discussed in 
the Problem Statement section of this 
chapter.

Taking into account all these aspects with 
regards to craftsmanship, this project will 
explore comparing digital fabrication 
tools with older techniques to determine 
if the definition of craftsmanship needs 
to be re-evaluated.

1.3 OBJECTIVE                              
The paper aims to give insight into the 
relevance of the project with respect 
to architectural conservation, to give a 
general understanding of 3D scanning 
and scanners, Digital Fabrication 
techniques, which include additive 
manufacturing techniques like 3D 
printing, subtractive manufacturing 
techniques like Computer Numerical 
Control Milling as well as laser cutting. 
Furthermore, the software tools 
required to ‘interpolate’ the geometry 
to be printed will also be covered. In 
this context, interpolation refers to the 
prediction of missing geometry using 
existing evidence, either documented 
or via evidence on site (if the damaged 
elements are part of a series of repeating 
elements). 

Ideally, conjecture would be avoided 
and the interpolation would be kept as 
accurate as possible. Informed by the 
literature review, a streamlined work-
flow will be created, that consists of the 
identification of a suitable candidate for 
the restoration process, the establishment 
of the criteria for the selection of the 
most applicable technology, the selection 
of the technology or technologies, the 
scanning of the existing geometry, 
the validation of the digital data, the 
manufacturing of the geometry and 
eventually, the on-site installation. 

This work-flow will be tested with the 
help of on-site experiments (a damaged 
structure will be scanned and repaired) 
and the conclusion of the experiments 
will be added to the existing literature, 
eventually leading to a manual for 
conservationists. 

that technology can also provide however 
is that the need for skilled craftsmen, 
essential for certain kinds of conservation 
efforts, can be negated, bringing down 
costs.  Secondly, conservation efforts are 
very time intensive, with the ongoing 
restoration of the Parthenon currently in 
its 40th year with an estimated end date 
of 2020 (“Acropolis on course,” 2005). 
During these efforts the monuments are 
usually covered with scaffolding or kept 
out of the public domain, disconnecting 
the population with their history. 

With technology, the time spent on site 
can be reduced, since 3D Scanning is less 
time intensive than traditional surveying 
techniques and machines can work day 
and night without a break. 

3D scanning is currently being 
extensively used in the field of art, 
notably the digitization of Matisse 
sculptures in 2002-2007 for virtual 
comparison, something that would have 
taken many tools, calipers and surveyors 
before the advent of 3D scanning 
technology (Wachowiak & Karas, 2009). 
With the use of additive manufacturing 
technology for instance, it is also possible 
to create hollow or optimized objects 
with internal lattices, something that 
is not possible by traditional carving 
techniques, making the objects lighter 
while retaining most of their strength.

1.4 PROBLEM STATEMENT                

With the increasing prevalence of 
technology comes a higher standard of 
living which consequently increases the 
cost of human labour. It is a fact that 
skilled craftsmen are rare in the 21st 
Century, especially specialists in the 
materials and techniques that might 
be required for the restoration of built 
heritage (Bourdieu, 2013). An advantage 

1.5 GOAL                                                    
The goal of this project is to improve 
upon the tool-sets available to conserva-
tionists by making use of the latest tech-
nology, thereby combining the old with 
the new. There is ample research in the 
fields of 3D scanning and Digital Fab-
rication, as well as the application of the 
combination these technologies in the 
regeneration of art and even bionics. 

This project can provide insight into 
how technology can be introduced into 
the field of architectural conservation 
which has traditionally been resistant to 
new technology. It will also give insight 
into the role of the craftsman and the 
relevance of craftsmanship in the digital 
world.

1.6 RESEARCH QUESTION
& SUB-QUESTIONS     

‘What are the influencing 
factors in the use and selection of 
LIDAR and Digital Fabrication 
for the patching of ornamental 
heritage? ’

The main research question gives rise to 
certain related sub-questions, such as:

i. Is digital fabrication for patching 
applications more economical than 
traditional techniques?

Note: This entails the cost comparison of 
newer techniques with the techniques used 
traditionally by craftsmen.

ii. What are the possibilities of hybrid-
ization of techniques (combination 
with traditional methods) for patch-
ing with Digital Fabrication?  

iii. Is the use of Digital Fabrication for 
patching advantageous for reversibili-
ty?

iv. Can a person without tradition-
al craftsmanship experience achieve 
usable results with Digital Fabrica-
tion?

v. What is the role of the craftsman in 
Digital Manipulation and Digital Fab-
rication? (Subjective)

vi. What is the role of the craftsman 
in Digital Manipulation and Digital 
Fabrication? (Subjective)

vi. What are the primary limiting 
factors when patching using LIDAR 
and Digital Fabrication technologies 
as they are today?

vii. What kind of role does software 
play in the patching via digital fabri-
cation process?

The answers to these questions and the 
conclusions can be found on Page 81 in 
the conclusions section.

Figure 6. Stonemason using hand tools Source: PolandPoland

Figure 7. An architecture student interfacing with a computer. Source: Author
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1.7 METHODOLOGY

The crux of the research topic is 
fragmented into different sections: 
scanning, interpolation and fabrication. 
In order to find the optimum methods 
for the scanning and printing aspects of 
the restoration, quantitative data has to 
be derived via experimentation. 

The data would then be compared and 
sorted and finally, deductions would 
be derived. For the interpolation of the 
missing geometry however, the nature 
of the research is partly exploratory as 
opposed to empirical, due to the highly 
subjective nature of conservation theory, 
which comprises a spectrum of varying 
schools of thought. Conversely, the 
technical aspects of the interpolation 
(the use of software, the detection of 
errors etc.) would be quantitative.

As depicted in the diagram, the 
Knowledge Base of the project is 
informed by the subjective aspects of 
professional opinions (via interviews 
with architectural conservationists and 
craftsmen), the literature review and the 
results of the experiments. The literature 
review and experimentation both inform 
each other (the results of the experiments 
may reinforce or contradict existing 
literature). The case studies inform 
both the literature review and vice 
versa (via discovery of new cases from 
existing literature. New cases can also be 
discovered by means of field research, or 
discovered cases via the literature may 
lead to other discoveries that reinforce 
the field research in turn. The field 
research helps locate ideal candidates 
(site selection) for documentation 
and experimentation. Finally, the test 
candidates (the selected candidates for 
experimentation) are determined via a 
combination of the available applicable 
hardware and the complete list of 
candidates discovered.

The final products of the research would 
then be the final report containing 
the literature review, interviews, the 
selected candidates, the documentation 
of the experimentation and the final 
manufactured products. 

1.8 SCOPE & 
CONSTRAINTS    

The limitations of the technology and 
the availability of some equipment 
will be the most significant constraint. 
Particularly concrete 3D printing or 
printing any material that tries to 
emulate stone, as well as other non-
polymer materials. Their resolution and 
strength in particular, at least in the 
mainstream, is considerably lower than 
current polymer printing technologies. 
The limitations of milling technologies 
like the size of the component or drill bit 
may also be a factor.

3D scanning technology whilst still under 
development, is comparatively advanced 
and can provide quite usable resolutions. 

An issue that may rise however is the 
portability of the scanning equipment, 
the laser scanners in particular, which 
are professional grade and can weigh 
up to 30 Kg. They also need to be 
mounted and transported with care 
and professional supervision is often 
required. Cameras for photogrammetry 
however don’t face these issues as they 
are lighter and relatively inexpensive but 
can produce considerably lower quality 
results in non-ideal conditions.

Literature Review

Experimentation

Knowledge Base

Field Research

Site Selection

Availability of Hardware

Professional Opinions

Case Studies

Restoration is a constituent of architec-
tural conservation, which also encom-
passes preservation, reconstruction and 
rehabilitation. All of the aforementioned 
approaches are dependent upon the 
charter being followed by the conserva-
tionists or their personal reflection on 
conservation. There is a fundamental 
difference between approaches to resto-
ration world-wide, the most prominent 
being the difference between Eastern and 
Western approaches. 

In Japan for example, most of the con-
struction is wood based, making the life 
cycles of buildings considerably shorter 
than their Western stone and brick based 
counterparts. This difference affects 
the way they approach restoration. 
More importance is given to restoring 
a  building to its original state as the 
original craftsman intended, discounting 
the numerous additions or attempted 
restorations that have been performed 
on it over the centuries (Larsen, ‎1996). 
This is contradictory to the Western 
approach, which attaches importance 
to all the subsequent modifications to 
the structure and form of a building. 
Because the Japanese pay homage to the 
original craftsmen of their built heritage, 
they retain the techniques and materials 
originally used, making the use of 
technology incompatible with their res-
toration philosophy and perhaps also in-
compatible with this graduation project.

Nonetheless, the definition of authen-
ticity in restoration remains subjective, 
with there being no equivalent word in 
the Japanese language (Larsen, ‎1996 ). 

There is however an aspect of restoration 
in Japan that is compatible with this 
project, the idea of Kintsugi (repairing 
with gold), primarily followed for the 
restoration of broken ceramic pottery. 
The idea being to emphasize the breakage 
as a stage in the life of the vessel by 

repairing it using a lacquer infused with 
gold, silver or another precious metal. 

This approach is compatible with some 
Western ideas of restoration since it 
accentuates the contrast between the old 
and the new, to appreciate the life lived  
by an object (or a building). 

Having considered the stark differences 
in restoration theory from region to 
region (also the subtle differences within 
regions), comparison with the Western 
model of restoration would be more 
applicable to this project, especially since 
it incorporates the use of technology.

2.1 DEGREES OF 
INTERVENTION 

(ACCORDING TO BERNARD FEILDEN)

According to British conservation 
architect Sir Bernard Feilden (whose 
works include the conservation of the 
Taj Mahal and Great Wall of China), 
architectural conservation encompasses 
a spectrum of seven degrees of interven-
tion: ‘(1) prevention of deterioration; 
(2) preservation of the existing state; (3) 
consolidation of the fabric; (4) restora-
tion; (5) rehabilitation; (6) reproduction; 
and (7) reconstruction’ (Feilden, 2008). 

Figure contextualizes Digital Fabrication 
with respect to the discussed degrees of 
intervention. The figure helps clarify that 
Digital Fabrication functions independ-
ent of these different degrees of interven-
tion and is rather a tool that can be used 
by conservationists for any appropriate 
degree of intervention but primarily 
when additional material is required. 
Since Digital Fabrication involves a 

2. CONTEXTUALIZING DIGITAL FABRICATION 	 
AND CONSERVATION
Bernard Feilden, Authenticity, Degrees of Intervention and Relevance

Figure 9. Degrees of Intervention. Source: Author

Figure 8. Structure of Research. Source: Author

Figure 10. A Japanese cup repaired with 
Kintsugi. Source: thisiscolossal
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group of techniques, it can be applied to 
aid various types of conversation efforts 
which can range from preservation to 
reconstruction. Feilden’s definitions of 
these degrees of intervention are summa-
rized with their relation to Digital Fabri-
cation in the following sections. 

2.1.2 Prevention of 
Deterioration

This is the least intrusive degree of 
intervention and it involves controlling 
the immediate environment of the built 
heritage and thereby slowing decay and 
damage. According to Feilden, such 
procedures include but are not limited 
to: control of humidity, temperature 
and light and also measures to prevent 
damage from human intervention, 
like fire, arson, theft and vandalism. 
Deterioration can also be prevented by 
reducing air pollution in the general area 
and relocating traffic, thus preventing 
damage from vibrations. Such measures 
can be enforced by regular inspection 
and general cleaning of the site. Digital 
Fabrication becomes relevant at a higher 
level of intervention since it involves 
direct manipulation of the site and 
therefore its potentials lie higher on the 
spectrum.

2.1.3 Preservation

In preserving an example of built heritage, 
a direct intervention has to be made to 
the structure since preservation involves 
keeping the site in its existing state and 
preventing further deterioration. This 
can involve repairs that are necessary to 
prevent the site from decaying further 
and reducing the damage caused by 
the flow of water, chemical agents and 
different types of pests and micro-
organisms. Since no new geometry is 
being generated, Digital Fabrication 
does not have many potential uses at this 
level of intervention.

2.1.4 Consolidation

Also known as ‘direct conservation’, 
consolidation necessitates the physical 
modification of the fabric of the built 
heritage with the introduction of 

that involve intricate craftsmanship. 
While it may still be possible to create 
such geometries, time constraints and 
economic viability can make Digital 
Fabrication the more feasible choice. 
Consolidation also lies within the 
Digital Fabrication framework since the 
involved technologies can be used to 
generate minimal intervention structural 
supports, particularly those requiring a 
certain degree of craftsmanship.

2.1.5 Restoration
According to Feilden, the core idea 
behind restoration is to revive the original 
concept or legibility of the historical 
site. Such an intervention can involve 
the replacement of damaged parts, the 
regeneration of decorative elements, as 

adhesives and structural supports in 
order to ensure the continued structural 
integrity of the construction. According 
to Feilden, consolidation should 
only be carried out if the structural 
elements have reached the limit of their 
structural integrity and can no longer 
face future hazards without failing. 
Feilden encourages the use of traditional 
methods to achieve these changes but 
where such methods are inadequate, 
appropriate modern techniques can be 
used, provided that they are temporary 
or reversible. 

Keeping this in mind, Digital 
Fabrication should primarily be used 
for the regeneration of geometries that 
cannot be easily generated via traditional 
techniques, such as complex geometries 

2.1.7 Reproduction
This entails the recreation of extant 
artefacts that have been lost but their 
archaeological evidence remains. In 
many cases, damaged or decaying parts 
can also be reproduced and replaced. 
According to Feilden, the end goal is to 
retain the aesthetic harmony of the site. 
Another example can be the complete 
reproduction of an artefact to replace 
the original, if it needs to be protected 
from the elements. Feilden gives the 
example of Michelangelo’s ‘David’ 
(Figure 13) which was removed from 
Piazza della Signoria, Florence to protect 
it from the weather and replaced with 
a replica. Digital Fabrication can aid 
this process by making the scanning 
and reproduction of elements faster 
and easier with the use of 3D-Scanning 
and additive manufacturing technology 
amongst others.

2.1.8 Reconstruction
The final degree of intervention in 
conservation, as defined by Feilden, 
reconstruction necessitates the use of 
completely new materials to replace an 
entire historic site that has been damaged 
by natural or man-made disasters. Such 
interventions according to Feilden, 
consequently do not have the patina of 
age but they must nevertheless be based 
on archaeological evidence and never 
conjecture. Feilden also classifies the 
moving of entire sites as reconstruction as 
such an action disconnects the site from 
its original context and therefore affects 
its cultural significance, something that 
conservationists always try to retain. 
While Digital Fabrication can easily 
aid in such a process, it goes out of the 
domain of this research since it primarily 
focuses on the repairing of existing 
geometry whilst trying to remain within 
the extents of conventional conservation 
values.

2.2 RELEVANCE
In the context of Digital Fabrication, 
the idea of restoration would not 
follow the strict definitions imposed by 
conservationists at this time since due 
to the constraints of current additive 
manufacturing technology, it would 
not be possible to truthfully recreate the 
geometry using the original materials. 
It is possible however to emulate their 
‘materiality’ by selecting a printing 
material that has similar properties to 
the original. 

An example of truthfulness in the 
selection of materials can be seem in 
the acquisition of the new marble for 
the reconstruction of the Parthenon, 
which was mined from the same quarry 
as the original marble, the Pentelicon 
quarry (Binns, 1984). While modern 
techniques may not be as truthful as the 
aforementioned, it can become the best 
choice when either economic constraints 
or the unavailability of skilled craftsmen 
render traditional techniques infeasible. 
The selection then becomes a matter of 
sentiment versus economy and time. 

well as cleaning of the structure. All such 
interventions have to be made according 
to archaeological evidence and with 
proper respect of the original design 
and material according to Feilden. He 
goes on to say that while regenerated 
parts should integrate harmoniously 
with the structure, they should be 
easily distinguishable from the original 
material so that historical evidence is 
not falsified. Furthermore, he says that 
additions from all periods should be 
respected since any contribution can be 
considered a ‘historical document’ that 
needs to be preserved.

Restoration also includes ‘anastylosis’ or 
the restoration of a site by the rearranging 
of the original materials/structures on 
the basis of archaeological evidence. 
Feilden warns that if taken too far, such 
a technique can make the site ‘look like 
a film set’ and ‘devalue the message of 
the site’. While anastylosis is not directly 
relevant to Digital Fabrication since it 
does not involve the generation of new 
geometry, other aspects of restoration, 
replacement of damaged components 
for example, can easily potentiate its use.

2.1.6 Rehabilitation

Adaptive reuse is a way of making 
conservation efforts more economically 
feasible. In this way, a historic site can 
retain its use or can house another 
function which in turn generate revenue 
which can be used in the maintenance of 
the site. An example of this can be the 
Architecture Faculty at TU Delft (BK 
City) in the Netherlands (pictured in 
Figure 12), the construction of which 
began in 1917 for use as a chemistry 
building, later becoming the main 
administrative building in 1948 (“The 
building: ‘BK City’,”). The building 
was transformed into a modern campus 
in 2008 after the original architecture 
building burned down (Rob van 
Hees, 2014). With the use of Digital 
Fabrication, it can be possible to 
introduce more durable materials to 
withstand the pressures of everyday use 
while maintaining the materiality of the 
original material and creating contrast.

Figure 11. Restoration of the Parthenon. Source: drtana (Flickr)

Figure 12. TU Delft Bouwkunde Model Room. Source: Eekhout Bouw

Figure 13. Replica of David. Source: Wikipedia
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The Annie Pfeiffer Chapel in Florida 
Southern College, Lakeland, Florida, 
USA is a structure designed by architect 
Frank Lloyd Wright and completed in 
1941. It is part of a group of buildings 
designed by Wright, collectively known 
as the ‘Child of the Sun’. Damage to the 
building has been caused by hurricanes, 
previous restoration attempts and daily 
wear and tear.

The restoration work was initiated by 
Mesick Cohen Wilson Baker Architects 
with the final phase of the restoration 
work due to finish by July 2015 
(MCWB, 2014).

3.1 RESTORATION                            
The primary candidates for restoration 
using additive manufacturing were 
the ‘textile’ style concrete tiles that line 
the facade of the building. The use of 
additive manufacturing/3d -printing was 
key since the old hand-crafted molds had 
since been lost (MCWB, 2014). 

MCWB chose to use 3d-printed 
Teflon in combination with wood to 
recreate the molds without the need 
for expensive and rare craftsmanship 
that would traditionally be required, 
minimizing costs and time consumed. 
It was not specified why the blocks 
were not directly printed but it can be 
speculated that this was either because of 
the unavailability of concrete printers or 
their current printing resolutions which 
are prohibitively low for the geometry of 
the blocks.

3.2 FABRICATION  
The use of 3D scanning was not necessary 
for this process since the original 
drawings of the tiles were available 
(Horton, 2014). The negative geometry 
was subsequently determined by using 
those drawings and he input for the 
3D printers was generated. The entire 
approach was completely hybridized 
with the use of some handmade wooden 
elements and CNC milling technology.

Figure 15. Examination of textile tiles. Source: MCWB Architects

Figure 16. Hybridization of Techniques. Source: MCWB Architects

Figure 14. The Annie Pfeiffer Chapel (South West Corner) Source: Florida Southern (Flickr)

3D Printing, Textile Tiles & Molds
3. CASE STUDY – ANNIE PFEIFFER CHAPEL Architect Jeff Baker, a partner at MCWB 

reportedly said,

“We tried various printer types, different 
types of materials, and various software 
programs—all with seemingly infinite 
setting options—to determine how 
to print the parts and get them to 
release from the molds… it’s clear that 
3-D printing, combined with CNC 
machining, will be the way of the future 
for these and similar molds.” (Horton, 
2014)	

The implication being that with current 
technology there is no single technology 
that can entirely cover all aspects of the 
restoration process but a hybridization of 
multiple techniques has to be carried out 
for optimum results. 

Since the project does not have any 
documented papers associated with 
it, there is no way to determine the 
constraints and issues involved in the 
project. Attempts to contact the firm 

have been in vain. It can be deduced 
from the comment however, that the 
issue of designing the molds so that they 
release the parts smoothly was taken into 
consideration and that hybridization of 

the methods (using CNC machining) 
was important to get the optimum 
results. 

Figure 18. Prototype of manufactured tile. Source: MCWB Architects

Figure 17. Section of 3D Printed Mold. Source: MCWB Architects
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Ceramic Tiles, 3D Scanning, 3D Printing in Color & Price vs Quality Comparison

4. CASE STUDY – CERAMIC TILE FROM THE 
GREAT SYNAGOGUE OF TIMISOARA

This case study documents a series of 
experiments performed at the Faculty 
of Architecture, Politechnica University 
Timisoara, Romania by Gheorghiu and 
Andreescu (2015). The chosen object was 
an ornamental ceramic tile measuring 
233 x 233 x 35mm from the main façade 
of the ‘Great Synagogue’ built in 1865, 
from the ‘Citadel of Timișoara’, a city in 
modern day Romania.

In the recorded processes, the tile was 
reproduced multiple times using a 
variety polymers and not the original 
ceramic material. It was not specified 
why the original material was not used 
but it can be reasoned that it was because 
of the high cost and limited availability 
of ceramic printers. The process was 
performed in three steps, 3D scanning, 
data processing and 3D printing. 

Although the scanned data was also 
gathered via a ‘semi-pro’ and a consumer 
laser scanner but the final data was finally 
extracted using digital photogrammetry 
(which was the first choice because of 
cost and availability) with an overlap 
of 75% - 80%. Reference markers were 
attached to the geometry for accurate 
scaling. It was suggested that a camera rig 
called ‘Linear Motion Central System for 
Digital Photogrammetric Survey’ which 
consists of a motorized four axis camera 
mount controlled via a programmable 
controller could be used to increase the 
speed and accuracy of the scans. Such 
a rig was however not available for the 
scans.

The data processing was done using 
software packages ‘BDModeler’ and 
‘Photoscanner’ and the final result was a 
textured solid. The data validation steps 
included checking the scale and wall 
thicknesses of the model, the polygon 
count, the file format, the orientation of 
the normals and the manifoldness of the 
model. For the final step, four different 

printing technologies were used, FDM 
(using PLA), SLS (using Nylon 12), 
Project (using power infiltrate and 
CMYK binders) and Polyjet (using 
polymerized vero white plus).

It was determined that the Polyjet 
method was superior in both quality and 
in terms of price (122.50 EUR) whilst 

standard FDM printing provided a cheap 
(6-8 EUR) but low quality solution. The 
objective of the research was just the 
successful replication of the title and not 
the installation. It was also suggested 
that FDM using PLA could also be used 
successfully if post-processed with paint 
or plaster.

Figure 19. Scanning of tile via Photogrammetry. Source: Adrian Gheorghiu

Figure 20. Closeup of Tile. Source: Adrian Gheorghiu

Figure 21. Pro-jet Printing Result. Source: Adrian Gheorghiu

Figure 22. SLS Printing Result. Source: Adrian Gheorghiu

Figure 23. FDM Printing Result (PLA). Source: Adrian Gheorghiu

Figure 24. Levels of Data Processing (from point cloud to mesh). Source: Adrian Gheorghiu
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5. EQUIVALENT TRADITIONAL METHODS
Repairing Techniques, Dutchman, Mortar Patching, Pantographs

5.1 DUTCHMAN REPAIR 
METHOD (INDENTING)

The Dutchman repair method is 
employed when a material is only 
partially damaged and the entire unit 
material does not need to be replaced.

This method is not limited to material 
type and the restoration possibilities 
range from masonry to woodworking.

Such repairs, particularly for stone 
repairs are generally secured using epoxy 
and stainless steel bolts for a secure fit 
(“Dutchman Repair,” 2011). The general 
process for such a repair for stone is 
illustrated in the adjacent figures.

Step 1

Identifying candidates for Dutchman 
repair, generally with patches of 
concentrated damage.

GENERAL DUTCHMAN REPAIR

Step 2

Relief cuts are added to the selected 
area (preferably with a diamond 
saw) to ease removal of material.

Step 3

The material is then carefully removed 
with a chisel (preferably pneumatic).  

Step 4

Steel rods are drilled into 
the exposed surface with 
an exposure of at least 
2 cm, complementary 
grooves are drilled into 
the replacement pieces 
for proper binding.

Step 5

The stone is first dry-fitted 
to ensure uniform fitting. 
Then it is fitted either using 
a natural bond mixture 
(hydraulic lime) or epoxy. 
The joints can then be 
pointed in using mortar and 
left to cure.

5.1.2 Stone Ionic Capital

Performed by the Canadian Atlantic 
Sandstone company, this Dutchman 
restoration was done on a section of an 
Ionic capital on a customs building in 
New Brunswick, Canada. The carving 
was performed in-situ using the existing 
ornament as a reference. It was finally 
attached using three steel pins and epoxy.

5.1.3 Stone Corner Repair

This restoration was performed by 
US based Treanor Architects and was 
posted on their blog. It documents 
the replacement of a weathered stone 
corner. There were no installation details 
provided but one of the noticeable 
aspects of the repair include almost 
negligible contrast between the old and 
the new material and the replication of 
the relief pattern on the stone.

5.1.4 Fluted Column
(Wooden)

This domestic restoration uploaded by 
Youtube use ‘cunnifjr’, used an intuitive 
way of repairing the fluting on a wooden 
porch column by fitting blocks of wood 
using the Dutchman method into the 
damaged sections and then routing the 
fluting in-situ using a router bit of the 
same radius.

5.1.1 Stone Fluted Column

This restoration carried out by the US 
based Tradesmen Group made use of the 
Dutchman method for the restoration 
of Grey Berea sandstone fluted columns 
on the east and west elevations of a 
courthouse building in Toledo, Ohio.  

The carvings were performed off-site 
using detailed reference drawings and 
then installed with the aid of stainless 
steel bolts and epoxy for a secure fit.

The resulting repair has a contrast which 
may gradually decrease over as the new 
material gains patina and general wear 
and tear.

Figure 25. Dutchman Repair of column capital. Source: Schnell Contractors

Figure 26. Fluted column repair (patch). Source: The Tradesmen Group

Figure 27. Dutchman Capital Repair. Source: Fundy Stonecraft

Figure 28. Corner repair. Source: Treanor Architects

Figure 29. Fluted Wood Column Repair. Source: cunnifjr (Youtube)
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5.2 STONE 
PANTOGRAPHIC INFILLS 

(ACROPOLIS)
For sensitive restorations where a 
minimal degree of intervention is 
required on the existing material, a tool 
called a stonemason’s ‘pantograph’ can be 
used to copy the existing geometry. The 
original form of this tool (which works 
in two dimensions) has traditionally 
been used by stonemasons to transfer 
lettering onto tombstones. 

An instance where this technique is 
being used is in the restoration of the 
Parthenon in Athens, with the aid of a 
specially developed three-dimensional 

stereo-pantograph being used to transfer 
the fracture geometry from casted 
gypsum copies of the missing segments 
(Toganidis, 2007). This new tool has 
flexible axes, making it easier to access 
blind spots. 

The pantograph has a probe which 
moves along the surface of the geometry 
to be replicated, these movements are 
transferred to another end which then 
directly carves the same surface on a 
volume of material. Technically, this tool 
could also be used directly on site but 
that may possibly add more logistical 
challenges. The newly manufactured 
Pentelic marble pieces have a marked 
difference in shade  from the original 

material and are installed at an offset 
from the original material to exaggerate 
the contrast between the old and the new 
(Toganidis, 2007. These are subjective 
aspects however and can vary according 
to the prevalent ethical guidelines of the 
time and region.

To connect the old and new marble, 
titanium clamps were developed for extra 
security (steel was used traditionally) and 
bound with white cement. 

Perhaps a major disadvantage of using 
these methods are the immense costs 
attached and the time required, making 
them only viable for sensitive restorations 
like for the Acropolis.

Figure 30. A 2D Pantograph. Source: Dickblick Online Store

Figure 32. Newly carved Pentelic marble being fitted. 
Source: YSMA, 2011

Figure 34. Titanium binding rods. Source: M. Ioannidou, ICOMOS  Figure 35. Carved voids for binding rods. Source: IIRPS Athens

Figure 36. Manual Patching. 
Source: John Speweik

Figure 37. Balustrade Patching (in-situ). Source: Plastic Surgeon Fine Finishers

Figure 31. Stereo - Pantograph used for the Acropolis restoration.
Source: YSMA 2011

Figure 33. Contrast between old and new marble with visible offset.
Source: IIRPS Athens

5.3.1 Stone Balustrades

Carried out by Plastic Surgeon Fine 
Finishers from the UK. Since there 
was limited time, molds could not be 
ordered for reshaping. The restoration 
was therefore performed freehand 
and in-situ with the aid of a variety of 
measurement tools.

NOTES
The use of pantography for the generation 
of infills is more expensive, requires 
more time and skill than all of the 
other techniques, mainly because of the 
requirement of specialized pantographs 
for the purposes of carving stone. It ties 

with digital fabrication when it comes to 
level of intervention however since both 
techniques minimize the modification 
of the existing fabric and material. 
Since the use of Digital Fabrication 
for restoration requires some degree of 

technical expertise, it can be compared 
to basic craftsmanship training. It can 
be argued however that a technically 
aware person might have less difficulty 
acquiring those skills as compared to a 
person not familiar with technology.

5.3 IN-SITU MORTAR 
PATCHING

When damage is either cosmetic or 
minimal, and using the same or similar 
material is not a requirement, in-situ 
patching can be performed using an 
appropriate mortar or filler. Such an 
intervention also reduces costs and time 
required on site.

In the case of stone, the ‘repair mortar’ 
used can vary in composition, ranging 
from natural options like a mixture of 
hydraulic lime with sand or aggregates 
and water. The mixtures can be prepared 
by the restorer or mason to match the 

5.4 COMPARISON WITH DIGITAL FABRICATION

texture and color of the surface to be 
repaired (“Stone repair & replacement,” 
2008). Synthetic options are usually 
manufactured in laboratories with 
polymers and aggregates, combined 
with a catalysing agent. These options 
are lighter than natural mortars and are 
quick drying. Dyes can be mixed into 
the mortars to match the color of the 
existing material if required. 

For more complex morphologies 
like ornaments, such restorations are 
generally performed by experienced 
craftsmen using hand tools like trowels 
and chisels.

Table 1. Comparison of techniques with digital fabrication

METHOD
LEVEL OF

INTERVENTION
(LOWER IS HIGHER)

ECONOMY
(LOWER IS MORE 

EXPENSIVE)

TIME REQUIRED
(LOWER IS HIGHER)

LEARNING CURVE
(LOWER IS HIGHER)

DUTCHMAN REPAIR 1 2 2 2

PANTOGRAPHIC INFILL 3 1 1 1

MORTAR PATCHING 2 4 4 3

DIGITAL FABRICATION 3 3 3 2
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6. TECHNOLOGY OVERVIEW

6.1 SCANNING
TECHNOLOGIES             

In order to generate the geometry to be 
printed for restoration, the built heritage 
structure needs to be scanned. This has 
two purposes, to record the existing state 
of the structure for posterity and to aid 
in the interpolation of the replacement 
geometry. 3D scanning can be divided 
into two general categories:

6.1.1 Contact Scanning

This technique involves the use of 
physical probes that touch the surface 
of the geometry and thereby generate a 
point-cloud via which the geometry is 
generated. They are typically used for 
geometric shapes and not recommended 
for organic shapes (Mongeon, 2015). An 
example of a contact scanning machine 
is a CMM (Coordinate Measuring 
Machine), a machine generally used in 
the manufacturing industry for testing a 
part or assembly for errors.

Since contact scanning, as the name 
suggests, involves physical contact with 
the geometry to be scanned, it is not 
ideal for the scanning of built heritage as 
there is a possibility of damage occurring. 
Further disadvantages include slower 
operating speed and limited resolution 
because a finite number of points are 
measured (3dscanco, 2015). With all 
these disadvantages taken into account, 
contact scanning can be ruled out for use 
with Digital Fabrication.

5.3.2 Non-Contact Scanning

The general principal behind such 
scanners is the use of radiation or sound 
waves to determine the distance between 
a reference point and the surface to be 
recorded. The radiation can be in the 
form of light (visible spectrum, including 
lasers) or x-rays. The sound waves are 
generally in the ultrasound frequency. 
The most common methods outside 
of the medical community however 
use light, especially for architectural 
scanning since this method is optimum 
for use on visible geometry.  These 
scanners are available in many varieties, 
some of which will be covered in this 
section. 

They are divided into two general types, 
passive and active, their difference in 
mechanism is illustrated in Figure. 

5.3.2.1 Passive Methods 

These scanners are passive because a 
probe (whether light or sounds) does 
not actively interact with the surface 
and instead algorithms are applied to 
received data to generate new data. The 
primary difference between passive and 
active methods is that in the former 
the radiation (in the form of reflected 
ambient light, a form of electromagnetic 
radiation) is not emitted from a source 

THis section covers the scanning and fabrication technologies that may 
be encountered during the restoration of built heritage.

on the scanner but is only absorbed by it, 
thereby the scanner only acts passively. 
These methods tend to be more cost 
effective since they only require a digital 
camera to record the reflected light and 
are also more compact. A few examples 
of passive techniques include:

1. Photogrammetry 

A form of ‘remote sensing’, the American 
Society for Photogrammetry and Remote 
Sensing defines photogrammetry as, 

“The art, science and technology of 
obtaining reliable information about 
physical objects and environment 
through processes of recording, 
measuring and interpreting photographic 
images and patterns of electromagnetic 
radiant energy and other phenomena” 
(ASPRS, 1980)

This method for the purposes 
of 3D scanning is called stereo-
photogrammetry, involves the use of 
subsequent photographs or other two 
dimensional images taken from different 
angles to predict the approximate 
location of surface points on the scanned 
object via the use of specialized computer 
vision algorithms. The algorithms used, 
combine multiple 2D images to predict 
a 3D Model by identifying identical 
feature points between images.

Various mainstream software packages 
are currently being used for amateur 
applications of photogrammetry, the 
most popular of which being Autodesk 
123D Catch and Microsoft Photosynth. 
A comprehensive list is available 
online on the Wikipedia page for 
Photogrammetry Software.

Problems and Constraints

Since most of the results of 
photogrammetry are calculated digitally, 
the algorithms can on some occasions 
fail. According to Foster and Halbstein 
(2014), there are a number of issues that 
can be faced during this process. They 
can be summarized as follows:

Occlusions & No. of Photographs                

Occlusion is the presence of an unwanted 
object in front of the object being 
scanned and the camera, this causes 
artefacts in the result because of the lack 
of information behind the object. Many 
current algorithms solve this problem 
using data from more images. Objects 
that have heavy occlusion can require 
photographs every 5–10° with an overlap 
of up to 50%. Low occlusion objects 
however only require images every 20° 
for optimum results.

Requirement of Features                    

It is integral to the way in which 
photogrammetry algorithms work 
that the images being processes have 
multiple features like patterns, strong 
lines or variety in depth. The algorithm 
uses these features to identify points for 
tracking. Considering this, it is more 
difficult for the algorithm to process the 
images if they have large empty or non-
focuses areas, an example being blank 
walls. The addition of reference features 
using tapes and stickers can yield better 
results. Conversely, repetition of features 
can also cause problems since it can 
make it more difficult for the algorithm 

to identify unique features. 

Reflectivity and Transparency                                          

Although the technical reason is not 
explicitly stated by Foster & Halbstein, 

it is mentioned that reflective and semi-
transparent elements like windows can 
pose problems. This is sometimes solved 
by spray painting a matte finish. It can 
be conjectured that these problems are 
caused because the glossy highlights and 
reflections visible on such objects are 
subject to change with the angle of the 
camera, thereby causing different images 
to appear in every photograph, which 
can cause problems when merging. 
Built Heritage can on occasion include 
extensive use of glass, however for 
applications of Digital Fabrication, the 
presence of glass is unlikely, yet glossiness 
may still be an issue.

Movement of Subjects                                      

 If the subject were to move significantly 
during the recording of the images, 
the algorithm would have difficulty 
aligning reference points (feature sets) 
and therefore the final result would have 
artefacts and distortion. This may not 
be an issue when scanning built heritage 
because of its static nature.

Consistency of the Lighting                                                

For optimum results, photogrammetry 
requires diffused lighting conditions, 
any directional light has the potential to 
cause strong shadows which can interfere 
with the algorithm. Due to this, flash 
photography is not recommended since 
it creates directional lighting conditions. 
Cloudy skies (diffused light) outdoors 
and the use of diffusers indoors therefore 
produces optimum results. This can be 
an issue when recording built heritage 
especially with time constraints when it 
is not possible to wait for ideal lighting 
conditions.

2. Photometric Stereo                                                            

This technique uses a singular camera 
viewpoint but extracts 3D information 
via images taken from different lighting 
directions. The light sources are point 
sources placed at a certain distance. 
The surfaces are approximated using 
algorithms that record the change in 
the intensity of the image at different 
illumination angles, thereby predicting 

the orientation of the surface (Wu, 
2003). This technique has limited 
applications for Digital Fabrication since 
the data would be polluted by other light 
sources, making the outdoor application 
(in an uncontrolled environment) of this 
method impractical, particularly during 
daytime.

3. Silhouette Methods                                                  

These methods pertain to the recording 
of the outlines of the scanned object 
from multiple angles. These silhouettes 
are then extruded to the origin of the 
camera and intersected with each other 
in 3D space (Karin Olsson, 2001). 
This intersection, called a visual hull is 
an approximation of the shape of the 
original object. The concavities of the 
objects are not recorded with this method 
and the final result is relatively crude. 
Due to these limitations this method is 
not useful for Digital Fabrication. It’s 
relative simplicity in generating these 
volumes however can be used for quick 
volumetric analysis.

5.3.2.2 Active Methods 

Such scanning involves the active use 
of radiation as a probe for determining 
the surface points of the geometry 
being scanned. As opposed to passive 
techniques, in active techniques the 
radiation is emitted from a source on the 
scanner, reflected back from the surface 
to be scanned and then detected by a 
sensor on the scanner. As mentioned 
earlier, these probes can be in the form 
of visible light, ultrasound or x-rays. 
This section however will only cover 
laser (visible light) scanning methods. 
These scanners typically require the 
use of a ‘laser ranger’, which is device 
on the scanner responsible for either 
measuring the distance or slant range to 
a selected reflective object. For laser light 
based scanners, there are three primary 
methods of data conversion:

1. Time of Flight 
    (Time Pulse Method)                  

These systems reflect laser light off the 
target surface which is then detected by 

Figure 38. Probe Head. Source: Wenzel

Figure 39. Passive vs Active scanning methods. Source: Author
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a light detector within the same system. 
Since light travels at a known fixed speed 
within a known medium like air, the 
distance to the point can be determined 
by the time elapsed. Typically, a laser 
pulse is generated by the scanner and is 
reflected off a rotating mirror or prism 
(to increase the field of view), the timer 
is initiated as soon as the pulse leaves the 
scanner and stops once it is reflected back 
and received by the receiving optics, as 
illustrated by the figure.

The range can be calculated using the 
following relationship:	

Where,

R is the distance or range from the target 
surface,

v is the speed of electromagnetic 
radiation (known value),

t is the time elapsed measured by the 
ranger in the scanner.

The elapsed time in combination with 
the angle of the mirror help determine 
the coordinates of the point. This is 
repeated multiple times depending upon 
the desired resolution and a point cloud 
is generated. ToF methods can generally 
be used between distances ranging from 
2m to 300m, with a measurement 
accuracy between 3mm and 6mm 
(Heritage3D, 2011) and are therefore 
suitable for architectural heritage 
scanning applications and consequently 
for digital fabrication.

2. Phase Comparison Method                                       

This method features a range finder which 
emits a continuous beam rather than a 
pulse, they are often referred to as CW 
(Continuous Wave) lasers. The emitted 
beam consists of a carrier wave which 
is modulated using a sinusoidal signal 
to include measurement information. 
The beam then reflects off the object 
or surface and is then detected by the 
scanner in a weakened state (because of 
atmospheric interference). The signal 

is then amplified and demodulated, 
to separate the carrier wave from the 
measurement data in the modulation. 

The difference in phase (often denoted 
by φ) between the incident wave and 
the reflected wave is then recorded. As 
illustrated in figure 3, it has to be realized 
that the beam has a fixed wavelength and 
a finite number of waves can fit inside 
a certain distance the wave travels, the 
location of the reflected wave w.r.t. the 
original wave can therefore be used to 
find the distance.

The final range of the scanned surface is 
therefore determined by:

Where,

R is the distance from the surface,

M is the number of wavelengths 
(integer),

λ is the known value of the wavelength,

Δλ is the fractional part of the 
wavelength.

Phase comparison systems have a higher 
rate of capture that other active methods 
and therefore can generate a denser 
point cloud (higher resolution), they also 
consequently have a higher computation 
cost (Heritage3D, 2011). Furthermore, 
because of the limited power of CW 
lasers, their range is typically limited 
to less than 100m (Gordon & Charles, 
2008). The range of such scanners, albeit 
less than ToF methods, is still adequate 
for recording built heritage, with the 
added bonus of higher accuracy, making 
them ideal for digital fabrication uses.

3. Triangulation                                                 

This method uses the cosine law 
by construction a triangle using 
the illumination direction and the 
observation direction derived from the 
angles of the source of the light and 
the angle at which the light is received. 

The source and receiver are kept at a 
fixed distance from the surface called 
the ‘baseline’, ensuring that the cosine 
parameters remain the same for every 
point scanned. The recorded angle and 
the second known separation, between 
the lens and receiver, help determine the 
location of the point and eventually a 
point cloud is generated. This method is 
typically used for distances less than 1m 
with an accuracy of 0.1mm but some 
scanners can extend that up to 25mm 
but with significant loss of accuracy 
(Heritage3D, 2011). Additionally, 
the measurements can be affected by 
sunlight and ambient light (Heritage3D, 
2011), making them unsuitable for 
outdoor use, which is one of the 
primary requirements for scanning built 
heritage for digital fabrication purposes. 
Therefore, triangulation scanners are not 
optimum for this method.

4. Microsoft Kinect                                                      

Although not a formal method of 
scanning, Kinect was released as a 
peripheral for the Xbox 360 gaming 
console in November 2010 with the 
intention of being used as a gesture 
recognition device to be used to actively 
interact with the console. 

After the SDKs (Software Development 
Kits) for Kinect were released, its 
applications were expanded. For 
example, the Kinect Fusion software 
library enables the use of the built-in 
RGB camera and infrared projector to 
gather visual information and depth 
information respectively, thereby 
extrapolating a 3D mesh in real time. 
Due to this mode of operation, Kinect 
is considered an active form of scanning. 

Although the real time scanning 
of geometry is not required for the 
purposes of scanning of built heritage, 
the static scanning applications of the 
Kinect system can be used in case other 
more formal systems are not available. 
This system can possibly also be used 
to acquire draft scans to determine 
the feasibility of a project before it is 
formally scanned.

Figure 40. Time of Flight Mechanism. Source: Author

Figure 41. Phase Difference Mechanism. Source: Adapted by Author

Figure 42. Triangulation Mechanism. Source: Author

Figure 43. Kinect live scanning and meshing. Source: 3D Printing Wizard
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6.2 MANUFACTURING
TECHNOLOGIES       

This section will briefly mention the 
history of digital manufacturing and 
its relevance to modern conservation. 
It shall only focus on the available 
technologies that are immediately 
relevant to conservation and only briefly 
mention other technologies that could 
be used in some instances (metal printing 
for example). Additive manufacturing 
till now (amongst others), has not 
had much of an impact on the field 
of the restoration of built heritage, 
particularly building restoration. One 
of the few examples that can be found 
is the restoration work being done on 
Frank Lloyd Wright’s Annie Pfeiffer 
Chapel in Lakeland, Florida, U.S.A. by 
Mesick Cohen Wilson Baker Architects 
discussed earlier in this report. In 
the project the procedure involving 
additive manufacturing focuses on the 
reproduction of the damaged ‘textile’ 
tiles on the facade of the structure rather 
than just the repairing of the existing 
tiles. 

6.2.1 Additive 
Manufacturing

Traditionally referred to as Rapid 
Prototyping and rather recently as ‘3D 
Printing’, additive manufacturing is by 
no means a recent development with 
roots going back to 1984 (Gibson, Rosen, 
& Stucker, 2015). Strictly speaking, the 
term ‘additive manufacturing’ describes 
any process whereby material is added 
onto existing material to create a product, 
as opposed to the removal of material 
that is seen in techniques like carving 
and milling. The use of computers 
however has enables the introduction 
of ‘3D Printers’, machines that enable 
the printing of geometries slice by slice. 
ASTM (American Society for Testing 
and Materials) International, a global 
standards organization has formally 
defined additive manufacturing as, 

‘A process of joining materials to make 
objects from 3D model data, usually layer 
upon layer, as opposed to subtractive 

manufacturing methodologies.’

These machines generally work layer by 
layer, extruding or curing the material 
in a malleable state (often molten) onto 
a defined plane using instructions from 
the computer (containing the master 
digital model) before moving on to the 
next plane and binding the material with 
the plane underneath. 

Nowadays, these techniques are not only 
being used to manufacture prototypes 
but also the final result, enabling the 
mass customization of consumer and 
industrial products and since the AM 
process does not require the creation 
of molds and presses, making the 
economics of scale irrelevant. It is also 
for the reason that it is now possible 
to print end products that Additive 
Manufacturing is no longer referred to as 
rapid prototyping (Gibson et al., 2015, 
p. 2). 

Additive manufacturing has also invaded 
the domestic realm, with compact 
3D printers purchasable at relatively 
affordable prices. Examples include 
the Ultimaker from Geldermalsen, the 
Makerbot (also comes with 3d scanning 
possibilities) and numerous schematics 
and kits that help you build a 3D printer 
at home.

6.2.1.1 Relative Merits  

Although additive manufacturing is 
often associated with speed (as seen with 
the traditional term ‘rapid’ prototyping) 
the actual manufacturing of the product 
is considerably slower than traditional 
methods since modern printers (with 
the exception of a few) often take hours 
to print more complicated geometries. 
The ‘rapid’ nature of this technology 
however is evident from the removal 
of ‘pre-manufacturing’ steps like the 
preparation of molds and having to 
adapt the designs to industry standards. 
Additive manufacturing skips these steps 
since the final product is directly derived 
from the digital model, this technique is 
therefore often referred to as ‘What You 
See Is What You Build (WYSIWYB)’ 
(Gibson et al., 2015, p. 9). Consequently, 

the final product also has potential to be 
much more geometrically complex than 
those achieved via traditional techniques.

Compared to subtractive manufacturing 
techniques like CNC milling which 
require the removal of material from a 
block of material to extract the product 
and molding and casting techniques 
like injection molding and die casting, 
which require the production of molds 
(sometimes quite extensive), additive 
manufacturing features negligible waste 
of material. Another potential for additive 
manufacturing is that it was conceived at 
the brink of the age of ‘the internet of 
things’. British economist Jeremy Rifkin 
defined additive manufacturing as the 
‘manufacturing model that accompanies 
the internet of things economy’ and 
something that would ‘provide everyone 
access to the means of production’ 
(Rifkin, 2015). 

Conversely, current additive 
manufacturing technologies also have 
considerable disadvantages. Since AM 
processes work with layers, they often 
require post-processing to produce 
smooth surfaces, therefore the final 
quality of the product is frequently lower 
than those manufactured via traditional 
methods. (Gibson et al., 2015, p. 11). 
Other drawbacks include the limitation 
of size, since 3D printers can only print 
inside a finite set of predetermined 
coordinates. This issue can however 
can be counteracted by mounting the 
nozzle on mobile robotic arms which 
can provide much more freedom of 
movement. High volume production 
is also not feasible, industrial usage of 
additive manufacturing is limited to 
instances where less than 10,000 units are 
required (Crump, 2009). The materials 
currently being used are also limited, 
since not all materials can be extruded 
or often have to be adapted to the 
extrusion process, losing many of their 
material and structural qualities in the 
process (Crump, 2009). Despite these 
shortcomings, additive manufacturing 
still provides considerable advantages, it 
may not replace traditional techniques 
completely, especially when it comes 

to high volume production, but it can 
easily prove to be a better alternative 
for manufacturing customized complex 
geometries. Considering the pace 
at which 3D printing technology 
is progressing (Sykes, 2014) , these 
shortcomings can quite soon be a thing 
of the past.

6.2.1.2 Types of Printing (by 
material)

Since this project deals primarily with 
architecture, this section will classify the 
available technologies with respect to the 
raw material input or the material that 
they try to emulate the materiality of.

1. Concrete

It has to be noted that concrete is not a 
homogeneous material but a composite 
material consisting of construction 
aggregate bound together with fluid 
cement. Therefore, different printing 
technologies may use Currently there are 
three main concrete printing techniques 
available, ‘D-Shape’, ‘Contour Crafting’ 
and ‘Concrete Printing’. All these 
technologies have produced prototypes 
and are still under constant development. 

D-Shape

This processes makes use of a ‘powder 
deposition’ method, using sand and 
stone powered as the granular material 
and a chlorine based binder (S. Lim, 
2011) which selectively solidifies the 
areas of the powder that need to be 
hardened. 

Each layer of powder is compacted and 
a mounted nozzle then deposits the 
binder. The rest of the powder acts as 
a temporary support. The loose powder 
is then removed revealing the final 
structure which has a print resolution 
(layer thickness) of around 13mm (S. 
Lim, 2011). 

There is also a possibility that some of 
the powder can be left inside any internal 
voids if proper measures are not taking 
to avoid it (Witte, 2015).  D-Shape has 
the advantage that it produces a high 
strength result but disadvantages include 

slow speed, rough surface, limited size 
(due to printing frame) and the need for 
post-processing (removal of the powder).

Contour Crafting

As the name suggests, this technique is 
used to print contours of the extruded 
shape.  The latest iteration of the 
technique has a print resolution of 
4 - 6mm uses two nozzles which print 
simultaneously (S. Lim, 2011). From 
each nozzle, a cement based paste is 
extruded against a trowel (sometimes 
two) which allows for a smooth finish (S. 
Lim, 2011). A third nozzle is often used 
to print concrete inside the void between 
the contours to add structural strength 
(Witte, 2015). 

Contour crafting was primarily 
developed to provide a high speed AM 
solution for the construction industry 
(S. Lim, 2011), since it prints vertically, 
it is optimal for the printing of walls.  
This provides the opportunity to also 
integrate piping, insulation and wiring 

systems inside the voids in these walls 
(Witte, 2015). A disadvantage of contour 
crafting is that since it is primarily 
used to print vertical elements under 
compression, so when voids like doors 
and windows are required, a separate 
lintel has to be added before the printing 
can continue (S. Lim, 2011).

Concrete Printing  

This technique extrudes a concrete 
mixture using a single nozzle mounted 
on a frame and without a trowel and 
prints a resolution of 6 – 25mm  (S. Lim, 
2011). Additionally, the printed material 
gives a compressive strength (72-102 
MPa) which is 80-100% of the casted 
equivalent, making this technique a 
very feasible replacement for traditional 
concrete casting  (S. Lim, 2011). It is 
also possible to integrate reinforcement 
as part of post-processing (Witte, 2015).

2. Ceramics & Clay

A recent research paper by Travitzky et al. 
(2014) covers the problem of additively 

Figure 44. D-Shape Machine. Source: 3D Printing Industry

Figure 45. Contour Crafting Machine. Source: Our Tech Future
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manufacturing ceramic materials in 
detail. The paper has classified these 
technologies according to their process, 
these technologies include 3D Printing, 
Selective Laser Sintering, Extrusion 
Freeforming, Stereolithography and 
Laminated Object Manufacturing.

The paper concluded that although 
Stereolithography exhibited the best 
surface quality, it used a very limited and 
expensive variety of materials, meanwhile 
3D Printing provided a limited surface 
finish but allowed the use of a much 
wider array of materials and also gave 
more control over the shape and micro-
structure of the geometry (Travitzky et 
al., 2014). Some of these technologies 
from the paper are summarized in table

3. Wood  
Although wood cannot be directly 
printed, its appearance can be emulated 
using wood-like particles or sawdust. 
Belgian company i-materialise and 
Japanese company Rinkak provide 
Selective Laser Sintering (SLS) solutions 
for printing objects that give the 
appearance of wood. According to 
the imaterialise (2015) website, their 
proprietary powder is heated to near its 
melting point and bound together layer 
by layer using a laser, as is standard SLS 
procedure. It is however not mentioned 
how this powder derived from wood 
is melted since wood combusts before 
it can melt (Cheng, 2010). However, 
low strength (imaterialise, 2015) and 
low resistance to water still keeps 
these materials from becoming proper 
substitutes for wood. A better option 
for replacing wooden components 
for restoration purposes would be 
subtractive manufacturing techniques 
like multi-axis CNC milling.

4. Polymers  

Traditionally, architecture did not 
commonly make use of polymers or 
polymer components, thermoplastics 
and thermosets have only recently 
gained popularity. They can be found in 
the production of utility components, 
window and door systems, flooring etc. 
Nowadays, the field of architectural 

conservation primarily deals with 
buildings from the pre-plastic age. In the 
context of digital fabrication however, 
plastics can be used in the in-direct 
application of additive manufacturing, 
primarily for the production of molds. 
Polymer 3D printing technologies today 
can achieve much higher resolutions 
of printing than concrete printers for 
example, because the nature of the 
material suits the process (it is possible 
to print much thinner layers). This 
provides the possibility of being able to 
print molds at a much higher resolution 
than is permitted by concrete printing 
techniques without the need for post 
processing via milling. Some selected 
relevant techniques will be explored in 
this paper.

Fused Deposition Modeling (FDM)

The most common method of additively 
manufacturing polymers today is 
Fused Deposition Modeling (FDM), 

this technique makes use of a heating 
chamber that liquefies polymers fed in 
the form of a filament (Gibson et al., 
2015, p. 160). The filament is fed into 
the chamber via a spool in a ‘tractor wheel 
arrangement’, which is also responsible 
for the extrusion pressure. The parts 
manufactured via FDM are some of 
the strongest from polymer based AM 
processes (Gibson et al., 2015, p. 161). 

FDM printers are found in many 
different configurations, some common 
ones are Cartesian, Delta and Polar. As 
the name suggests, Cartesian printers 
use the Cartesian coordinate system (X, 
Y and Z-Axis), with the print bed (the 
surface being printed on) often shifting 
downwards (along the Z-axis) as the 
print progresses while the print head 
moves along the X and Y-axes (Campbell, 
2015). Delta printers also use the same 
coordinate system but feature a print 
head suspended via three moving arms 
(forming a D shape, hence ‘Delta’) and a 
fixed print bed, whilst Polar printers use 
polar coordinates i.e. a circular grid for 
the printing process (Campbell, 2015). 
In FDM, the material is extruded from 
the nozzle at a particular point, with 
multiple cylindrical extrusions forming 
each layer, since this nozzle is circular, 
it is not possible to print sharp corners 
(Gibson et al., 2015, p. 164). Other 
limitations of this technology are the 
speed (which is limited by the feed, 
liquefaction and the extrusion head 

Table 2. Ceramic Additive Manufacturing Techniques. Adapted by author from 

(Travitzky et al., 2014).

movement rates) and the anisotropic 
nature of the material (since it is printed 
in layers) (Gibson et al., 2015, p. 165). 
The printed parts usually have a higher 
tensile and shear strength in the X-Y 
plane than along the Z plane because of 
how the material is laid down (Stratasys, 
2015). Techniques have been developed 
to increase the strength of these parts 
however, such as a recent paper by Yale 
scientists recording experiments with 
filling voids in the printed geometry 
with high-strength resin (Belter & 
Dollar, 2015).

Stereolithography (SLA) 

This technique uses the solidification 
or ‘curing’ of a photosensitive polymer 
(epoxy or acrylic resin) in liquid form via 
the use of a light source; the light source 
provides energy to the liquid and induces 
a chemical reaction (the curing process), 
bonding the molecules together and 
forming the final cross-linked polymer 
(Bártolo, 2011). 

For the next layer, the platform is 
lowered and re-flooded with resin. This 
process is then repeated for each layer 
(which are also bound together) to form 
the final geometry. The resin is heated to 
30° to 40° C to decrease the viscosity of 
the resin so that it wets the new surface 
better but apart from that, temperature 
does not drastically affect the curing 
process (Strauss, 2013). 

The two main methods of projecting the 
light are either via a laser (slower because 
the laser projects a point) and a DLP 
(Digital Light Processing) Projector 
(which cures the entire computed plane 
at once and is thus faster). Like other 
printing methods, if there are overhangs 
or recesses, support material might have 
to be generated, which is later removed 
either manually or with the aid of a 
chemical bath.

Material Variation

Both FDM and SLA are compatible 
with a wide variety of materials, with 
the ideal material being one that is more 
suited for the type of end product being 
manufactured, with factors like speed, 
strength and the required detail taken 
into consideration. The two most popular 
FDM materials are the thermoplastics 
ABS (Acrylonitrile Butadiene Styrene) 
and PLA (Polylactic Acid) whilst other 
materials like PVA (Polyvinyl Alcohol), 
Nylon and PC (Polycarbonate) are 
also used for specialized applications, 
amongst many others. Compared to 
PLA, ABS is stronger, more flexible, 
and can be sanded, painted and glued 
together using ABS glue. Whilst PLA 
has the added advantage of being 
more environmentally friendly since 
it is biodegradable and is derived 
from renewable resources. PLA is also 
relatively tough, produces a higher 
resolution, is faster and can be painted 
(preferably with primer) but it is also 
brittle once it cools down, more prone 
to water absorption than ABS and is 
difficult to glue together (Matterhackers, 
2015).

SLA materials are not as readily available 
as ABS filaments since every 3D printer 
manufacturer has different conditions 
under which their material is printed, 
like the kind of irradiation (direct light 
or laser) or the viscosity of the resin 
required. These manufacturers then 
make proprietary thermoplastic and 
elastomer photosensitive resins available 
that are not interchangeable between 
printers, making the materials more 
expensive and rare (Grieser, 2015).

Comparison  

Compared to SLA, FDM printers have 
the advantage of having better material 
availability, are stronger (since the 
thermoplastics are directly extruded) and 
are more economical since the technology 
is relatively less complex and requires less 
maintenance (3Dsupplyguys, 2015b). 
SLA printers on the other hand can print 
at a higher resolution because of the 
precision achieved with lasers and DLP, 

and although the final product may need 
to be ‘baked’, the surfaces produced are 
smooth so no further post-processing 
is required afterwards. Despite these 
facts, the prohibitive pricing, technical 
sensitivity required (whilst handling 
the resin, for example) and restrictive 
availability and brittleness of the 
materials has affected the popularity 
of SLA printing when compared with 
FDM (3Dsupplyguys, 2015a).

Relevance
For the purposes of this research, the 
required 3D Printing methodology can 
be divided into two main categories: 
Direct Manufacturing, involving 
printing the required geometry  
(positive) via a 3D Printer using an 
appropriate printable material and In-
direct Manufacturing, involving printing 
the mold (negative) required to produce 
the needed geometry.

Although printing the positive (direct)
can have material limitations (especially 
since the object is printed in layers) 
it can be useful in recreating intricate 
geometries for the purpose of being 
used as a reference to create a mold. In 
this way less material is wasted, and the 
process can be economized. 

The mold (negative) can potentially also 
be printed so that another material  can 
be casted in it. This possibility helps skip 
the need to create a mold but since the 
mold needs to be larger than the positive,    
it requires a larger manufacturing volume 
which can be quite limited in modern 
3D printers. 

There are possibilities for hybridization 
as well, such as manufacturing certain 
parts of a mold via cnc milling and only 
using 3D printing for geometry that can 
not  be manufactured via other methods.  
Another hybridization method is 
manufacturing general volumes via low 
resolution 3D printing techniques such 
as concrete printing and then applying 
the final details using CNC milling.Figure 46.                            Source: Author

Figure 47.                              Source: Author
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6.2.2 Subtractive 
Manufacturing

As the name suggests, subtractive 
manufacturing deals with the removal of 
material from a stock to leave the desired 
form. In the field of digital fabrication, 
these machines are fed CNC (Computer 
Numerical Control) data and often 
referred to as CNC milling machines. 

There is a distinction between 
different kinds of digital subtractive 
manufacturing methods, namely cutting 
and machining. (Hauschild, Karzel, 
Hellstern, Kollmann, & Schönbrunner, 
2011) These techniques are summarized 
in the following sections.

6.2.2.1 Cutting Techniques

Cutting refers to the separation of flat 
materials with little to no variation in 
thickness. A distinction can be made 
between the few cutting process, namely 
shearing, jet-cutting and thermo-cutting.

Shearing

Shearing uses a die-head which is guided 
over the flat material using CNC data 
which controls the horizontal and 
vertical movement of the die. This is 
a purely cutting mechanism with a 
possibility of cutting up to 10 mm of 
sheet metal. Shearing is an entirely 2D 
process as the size of the head limits any 
3D processing (Hauschild et al., 2011).

Jet-cutting

Unlike shearing, this technique involves 
no cutting edge and uses either a laser 
jet , gas (plasma cutting) or water. The 
most common techniques, at least 
for architectural applications uses a 
mixture of water and an abrasive agent 
(like sand particles) to add abrasiveness.  
The abrasive agent can be excluded 
for softer materials but is required for 
harder materials like metals. The jet is 
shot at up to 1000 m/s and the cutting 
diameter can vary from 0.5-1 mm, with 
a thickness of up to 500 mm, depending 
upon the material. This technique can 
provide smooth cut edges with minimal 
loss of material and requirement for post 

processing. (Hauschild et al., 2011). 

Thermo-cutting

This technique as the name implies 
involves the use of concentrated energy 
to raise the temperature of the cutting 
point to ease the separation of particles. 
Two of the more popular techniques are 
laser cutting and wire cutting. 

Laser Cutting

Laser cutting uses as a high energy light 
beam to make an initial incision on the 
surface, afterwards a ‘process gas’ pushes 
the molten material on the surface 
downwards, to slice through the entire 
surface. Modern laser cutters can achieve 
speeds of up to 40 m/minute and can be 
quite efficient and economical and can 
be used on a large variety of flat materials 
(Hauschild et al., 2011). 

Wire Cutting

Wire cutting on the other hand is 
more of a prototyping tool than a final 
manufacturing tool. It is mostly used 
to quickly manufacture volumetric 
geometries via the use of a linear 
electrically heated wire primarily used 
to cut foam materials like polystyrene. 
Continuous passes can enable the 
manufacturing of complex volumes 
from a simple volumetric block. Even 
though there are material limitations, 
the manufactured foam product can 
be used as an initial part of a longer 
manufacturing process, as a guide for the 
making of molds for example (Hauschild 
et al., 2011).

6.2.2.2 Machining Techniques

Machining techniques (also known as 
milling) a set of motors rotates a tool 
and guides it along the material for the 
component to be manufactured. The 
milling head can be of varying sizes and 
materials depending upon the expected 
quality of the print and the kind of 
material used respectively.

2-axis milling is generally used in case 
laser cutting or water jet techniques are 
not viable, with the milling head being 
used as a cutting tool. This is not ideal 

since the manufacturing is limited by 
the speed of the machine and certain 
internal corners cannot be milled 
because of the limited minimal radii of 
the milling heads. Furthermore,  there 
is considerable waste of material caused 
by the milling action. 2-axis machines 
generally use a set of instructions or 
tooling paths generated by standard 
CAD programs.

Multi-axis milling machines generally 
range from 3 to 5 axes with the selection 
of the appropriate machine depending 
upon the complexity of the geometry 
to be manufactured. These machine 
generally require a 3D model in the 
industry standard STL format. Other 
software packages then use this file 
as a reference to generate the tooling 
paths as well as the accuracy and feed 
rate required. An important aspect of 
using milling machines is the accurate 
positioning of the part to be milled 
on the milling bench, which has to be 
adjusted according to zero point of the 
system for the most precise milling 
(Hauschild et al., 2011).

Multi-axis milling is often done with the 
aid of jointed-arm robotics to provide 
maximum degrees of freedom. These 
require extensive supervision however 
since the robots require human guidance 
to generate appropriate tooling paths to 
avoid self intersections. Robotic arms are 
generally only used when 6 or more axes 
are required for the milling to proceed.

7. GENERAL METHODOLOGY
3D Scanning, Interpolation,  Manufacturing Workflows

For the restoration of damaged 
ornaments via digital fabrication, a 
commonality can be found between all 
the different work-flows, ranging from 
the identification of  viable candidates 
to  the actual manufacturing of the 
products. Any variation in techniques 
would then be encompassed within these 
general steps. The steps (as deduced by 
the author) are as follows:

7.1 IDENTIFICATION OF 
CANDIDATES  

The first step in the restoration of built 
heritage is the identification of candidates 
that qualify for additive manufacturing. 
The preliminary prerequisites can be 
listed as follows:

i. The repair of the structure would tradi-
tionally require a skilled craftsman.

ii. The geometry to be replaced is com-
plex or double-curved making the use of 
traditional casting or carving methods 
difficult.

iii. It is possible to additively manufac-
ture the target material using current 
technology.

iv. It is possible to emulate the material 
and structural qualities of the original 
material with the printed material.

v. There is minimal internal damage and 
no voids that cannot be scanned.

vi. The restoration process would does 
not unnecessarily endanger any built 
heritage.

vii. It is possible to reversibly repair.

7.2 SCANNING 
PARAMETERS 

AND CONSTRAINTS

Before the geometry can be scanned, it has 
to be prepared for the scanning process. 
Depending upon the scale, complexity 
and reflectivity of the geometry, as well 
as the type of scanning technique being 
utilized, number of measured have to be 
taken before the 3D scanner can be used. 

According to a manual released for their 
software HORUS by BQ, a Spanish 
manufacturer of open source 3D 
scanners, the following conditions are 
necessary for optimal laser scanning: 

i. Optimal lighting conditions 

The object to be scanned should be lit 
with indirect light of medium intensity. 
This helps avoid any shadows forming 
on the objects and also reduces reflectiv-
ity and glare, increasing the performance 
of the laser scanner. 

If the texture or color of the object has 
to be scanned, then an additional light 
may be required, if not, the laser itself is 
enough to illuminate the scanning sur-
face.

ii. The material of the object 

The object should ideally have a matte 
finish; any reflectivity or glossiness can 
produce a glare which can interfere with 

the scanning process. If a transparent or 
shiny object has to be scanned, Maker-
bot (2013) recommends using tempo-
rary measures like cornstarch, talc, dry 
shampoo, flour, ‘developer’s paint’ or 
tempera paint. All of these options are 
reversible and can be removed after the 
scanning process.

iii. The object color

Red or dark colors in poor lighting con-
ditions or bright colors in bright lighting 
conditions can affect the reflectivity of 
the laser and therefore produce inaccu-
rate results. 

The aforementioned solution suggested 
by Makerbot can possibly also be used to 
solve this problem.

iv. The shape of the object 

Cavities, hidden faces, furry surfaces 
(Makerbot, 2013) can drastically affect 
the result. These issues can be fixed 
in the subsequent adjustment of the 
point cloud in the processing software. 
(HORUS, 2015)

7.2.1 Preparing the site
for scanning

The measures taken are usually dependent 
upon the kind of equipment being used 
for the scanning. The measures taken 
by Delfttech, the firm providing the 
scanners are as follows:

i. The day before the scanning has to 
be performed, the mirror and lens of 
the scanner are checked and cleaned if 
necessary. The batteries are also fully 
recharged.

ii. On site, any reference targets are 
placed on objects to be scanned if 
required by the scanning process.

iii. Before scanning can begin, a tripod 
is placed at the selected location and 
levelled to make sure it is horizontal.
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iv. An adjustable tribrach (a piece of 
surveying equipment used to quickly 
attach or detach instruments) is attached 
to the tripod.

v. The lens and mirror are rechecked and 
cleaned if necessary.

vi. The scanner is mounted onto the 
tribrach on the tripod and the tribrach 
is then adjusted to completely level the 
scanner.

vii. The scanner is switched on, and 
set-up with the name and path of the 
scan job, the scan number, the scan 
resolution and the scan quality.

viii. After the scanning process, the 
scanner, lens and mirror are cleaned and 
the batteries recharged to prepare the 
scanner for the next job. 

7.3 DATA VALIDATION 
AND INTERPOLATION

New geometry has to be interpolated 
in the software packages provided by 
the manufacturers or other third party 
commercial or open source software. 

Data from the scanner is generally 
collected in the form of a ‘point cloud’ 
which is a collection of points recorded 
by the laser on the scanner inside a 
three dimensional coordinate system 
(usually a local coordinate system of 
the scanner) (Hermary, 2014). After the 
scanning process, some of the important 
undertaken steps are:

7.3.1 Geo-referencing

Only if the collected point clouds need to 
be transferred into a different coordinate 
system, for example, when merging a 
scanned segment of a building with a 
model of the building (Lovas, 2010). 

7.3.2 Selecting an area of 
interest

Not all the scanned data is always 
relevant, unnecessary data or data from 
the periphery may be cropped out 
(Lovas, 2010).

7.3.3 Data conversion  

This step depends upon the nature of the 
geometry, whether it is regular or organic 
and free-flowing. 

The two types of geometry that the 
point cloud is converted to are Polygonal 
Models or Rapid NURBS solids. 
Essentially, the point cloud data usually 
in ASCII formats (essentially a list of 
points), needs to be converted to a 
manipulatable format that can be read 
by 3d modeling software. 

The choice of format also depends upon 
whether the model is to be used for 
digital modeling (actual state, irregular 
geometry) or reverse engineering 
(ideal state, regular geometry). For the 
former, the point cloud is converted 
to a polygonal model, which consists 
of multiple tessellated triangles or 
‘polygons’ formed by connecting the 
point cloud to generate the entire model 
(Direct-Dimensions, 2015). This STL 
format is usually preferred for this type 
of geometry and it is ideal for rapid 
prototyping or visualization applications. 

This method also suits digital fabrication 
for restoration since it records all the 
imperfections of the scanned object, 
which is essential for the recording 
and restoration process. For reverse 
engineering, rapid NURBS solids are 
generated by adding an additional step 
on top of the polygonal model, by 
wrapping NURBS surfaces over the 
polygonal frame (Direct-Dimensions, 
2015), typically exported in IGS format. 

An advantage that this format offers 
is that the data can be parametrized 
and is therefore easier to manipulate in 
software that offers parametric modeling 
(e.g. Autodesk Inventor, SolidWorks 
etc.) These two methods can also be 

hybridized to utilize some of the benefits 
of both (Direct-Dimensions, 2015).

The software packages used by Delfttech 
(some packaged with the 3D scanners 
being used) are, Z+F Lasercontrol 
Professional Plus (packaged with Z+F 
scanners), LFM (multiple sources) 
and Leica Cyclone (multiple sources, 
not limited to Leica). The meshing is 
generally performed using MeshLab, 
Leica Cyclone, 3D Studio Max or 
GeoMagic. Other freeware or shareware 
packages can also be used.

7.3.4 Data Inspection  

If required and if the original drawings of 
the selected geometry are available, the 
scanned model can be compared with 
the drawings to record any dimensional  
deviations (Direct-Dimensions, 2015). 
These deviations can then be represented 
as a color map that is overlaid on the 
model with the aid of certain software 
packages. 

7.3.5 Interpolation

This step determines the geometry to 
be manufactured, this would include 
sections that need to adhere to the 
scanned candidate(s) and ones that need 
to be modeled from scratch with the aid 
of documents or repeating features. 

Careful considerations would have to be 
made to include any tolerances required 
for the binding material. 

It would also have to be determined 
whether the new geometry would have 
to be manufactured in one piece or 
multiple fragments, depending upon the 
nature of the scanned geometry.

Steps also have to be taken to ensure that 
the nature of the geometry generated 
conforms with the manufacturing 
technique chosen. An example of this 
can be the generation of manifold 
meshes for the purposes of 3D printing 
or in the case of milling ensuring that 
there are no hidden surfaces or recesses  
that the milling tool cannot reach.

7.4 PREPARATION AND 
MANUFACTURING

After the meshing process, the model 
needs to be prepared for manufacturing 
via the chosen process. The production 
process would either be direct or indirect 
(via the use of molds). 

The choice of process would determine 
the materials and equipment to be used. 
It is required that there are no physically 
impossible artefacts in the scanned 
model, such artefacts have to be removed 
and the model cleaned. 

These steps can be performed with any 
of the modeling software listed before 
and may vary between different software 
packages. 

7.4.1 Additive 
Manufacturing

Workflow
Generally, a well prepared water-
tight mesh can be used for a variety of 
manufacturing applications. Gibson et 
al. (2015) for example, describe additive 
manufacturing as an eight step process. 
These processes can be summarized as: 

Step 1: Computer Aided Design  

The creation of the 3D model to suit the 
parameters of the 3D printer, in the case 
of digital fabrication, the conversion of 
the point cloud to a mesh.

Step 2: Conversion to STL  

Conversion to the standard STL file 
format accepted by nearly all 3D 
printers, it defines the closed surfaces on 
the exterior of the model.

Step 3: File Transfer and STL 
Manipulation  

Once the file has been transferred to 
the machine, it can be manipulated to 
determine the orientation, position and 
scale.	

Step 4: Machine Setup  

This step pertains to setting up the 
machine by providing an energy source 
and suitable environment as well as 
build parameters like layer thickness, 
temperature, timing etc.

Step 5: Build  

The printing process is mostly automated 
but may require supervision in case of 
unforeseen circumstances.

Step 6: Removal  

The printed piece has to be removed 
from the machine which requires 
actively interacting with the machine 
or in some cases waiting till the safety 
interlocks (engaged when temperatures 
are too high or there are moving parts) 
are disengaged.

Step 7: Post-processing  

This is mostly a manual process and may 
involve sanding, removal of supports etc. 
Chemical baths are sometimes used to 
expedite the removal of support material.

Step 8: Application 

Final touches like primer and/or paint 
can be added to prepare the product 
for use, depending upon the kind of 
material used. The 3D printer should 
also be reset and prepared for the next 
print, any required maintenance should 
be carried out.

7.4.2 Other Considerations

According to a white paper by Stratasys 
(2014), the generated STL file should 
not have any overlapping or miss 
surfaces, inverted normals, or bad 
edges (non-manifold). These errors 
can be detected by any STL viewing 
tool. Additionally, the wall thicknesses 
have to be appropriately determined 

according to the material filament being 
used (if the geometry is to be hollow or 
not completely solid). Every material 
has a minimum acceptable thickness 
for optimum results (Stratasys, 2014). 
Different materials have different ‘self-
supporting’ angles (usually around 45 
degrees), beyond which the material 
can tend to tip over. If the design of the 
print accounts for these angles, then the 
support material and consequently the 
build time can be reduced.

7.5 INSTALLATION ON 
SITE

The selected candidate(s) would then 
be repaired on-site with the printed 
additions installed with appropriate 
binding materials (preferably ones that 
allow reversibility). This process may or 
may not involve cleaning the existing 
fracture surface on the candidate to be 
restored.

7.6 ADJUSTMENTS AND 
DOCUMENTATION

Finishing adjustments and imperfections 
in the digital fabrication intervention 
can now be fixed and any changes to the 
site should be documented along with 
the materials and techniques used. 
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Ornamental architecture can still 
play functional roles, this 

categorization mainly alludes to 
the complexity of the morphology 

of the geometry.

In manufacturing terms, a 
pattern is a reference object 
that aids in the creation of 

molds that can than be used 
to cast another material.

In the absence of reference geometry, 
historical documents or photographs can 
be used to recreate the missing geometry. 

However, this method does require a 
certain degree of digital craftsmanship.

Depending upon the type of rot, the 
intervention can range from moisture 

control to removal of affected parts. When 
the removal of geometryis needed, a new, 

more simpler fracture geometry can be 
formed.

While digital fabrication can be 
used for the patching of 

non-complex geometry, traditional 
methods are well suited and more 

efficient for such instances.

New Fracture Geometry

D-shape is one of the few 
technologies that can print relatively 

high resolution objects while 
emulating the appearance of 

concrete with the use of sand and 
an epoxy binder. 

7.7 WORKFLOW SELECTION FLOWCHART
PATCHING VIA DIGITAL FABRICATION AND LIDAR
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Restoration using digital fabrication 
requires the symbiosis of different 
fields of technology to achieve the 
final result. These technologies include 
the use of hardware for the input of 
data, the analysis and subsequent 
manipulation of that data, and for the 
production of the physical output. In 
this section the available hardware and 
their specifications will be listed. The 
comparison of their results can be found 
in subsequent sections.

8.1 3D SCANNERS

The laser scanners for this research were 
acquired from Delft based scanning 
company Delfttech, which according to 
their website provides ‘3D laser scanning 
& engineering, consultancy, software 
solutions and training & education’. The 
hardware was used under the supervision 
of their engineers to ensure proper usage 
and maintain the accuracy of the results.  
The scanners acquired were the Leica 
HDS3000 and the Zoller + Fröhlich 
Imager 5010C. 

8.1.1 Leica HDSv3000

Manufactured by Swiss company Leica 
Geosystems (not to be confused with 
the German optics company Leica 
Camera), this pulse based laser scanner 
uses a time-of-flight system to record the 

point cloud. The ranger finder works in 
conjunction with a rotating mirror to 
increase the effective field of view. Details 
about the mechanism of action of such 
systems are discussed in the Technology 
Overview section.  

The scanner features an ‘integrated high 
resolution camera’ and can be linked to 
external digital cameras to increase the 
field of view. The raster images generated 
from the camera can be mapped to the 
mesh generated from the point cloud, 
giving full color meshes.

8.1.1.1 Connectivity

The scanner is marketed towards 
professionals and has an accuracy that is 
considered survey-grade. It can be linked 
to a standard modern laptop using an 
Ethernet cable, making a laptop with 
an Ethernet port a requirement (many 
ultraportable laptops lack one). 

8.1.1.2 Dimensions and 
Weight

Weighing 17kg with the additional 
weight of 12kg for the power supply, and 
measuring 265mm x 370mm x 510mm, 
it is not the most portable device on the 
market but with adequate transportation 
can easily be easily assembled on a tripod 
(also provided) on site. Other relevant 
specifications can be found on the 
adjacent table.

8.1.1.3 Export Formats 

The scanner directly exports the point 
cloud as ASCII point data (these include 
the XYZ, SVY, PTS, PTX and TXT 
formats). Other formats include DFPX, 
Leica’s DBX format and the Land 
XML format. Indirectly (via the use 
of plugins), AutoCAD, MicroStation, 
PDS and AutoPLANT formats are also 
supported.

8. HARDWARE INVENTORY
Laser Scanners, 3D Printers, Specifications

Table 4. Relevant Specifications of Leica HDS3000 Scanner

Type of Instrument Pulse, Time of Flight Ranger Finder

Operating Temperature 0° to +40° C

Laser Class 3R

Field of View

  Horizontal 360° (maximum)

  Vertical 270° (maximum)

Scan Range 300m

Scan Rate Up to 4,000 points/sec

Scan Resolution

  Spot Size From 0 – 50m range, 4mm (FWHHa), 6mm (Gaussianb)
  Maximum Density 1.2mm

Scanning Optics Single mirror, panoramic

Scanner Drive Servo Motor

Power Supply 36V

Power Consumption <80W avg.

Note: All specifications from Leica Geosystems specifications list.
a Full Width Half Height approximation (measured till 50% of center maximum)
b Gaussian approximation of intensity (maximum at center of spot)

8.1.2 Zoller + Fröhlich 
Imager 5010C

Manufactured by German engineering 
company Zoller + Fröhlich, which started 
off as a supplier of control systems for 
the automotive and engineering industry 
(started manufacturing laser scanners in 
2002), the Image 5010C is a relatively 
compact phase comparison scanner. 

Like the HDS3000, the Imager 5010C is 
a high-end product and also features an 
integrated camera (CMOS sensor) and 
a rotating mirror for increased field of 
view. Furthermore, the scanner conforms 
to IP 53 standards and is therefore dust 
and water resistant. Additional relevant 
specifications can be found in the table.

8.1.2.1 Dimensions and 
Weight 

The Imager is lighter and more compact 
that the HDS3000, weighing in at 9.8kg 

and with a size of 170 x 286 x 395 mm. 
The power supply is also significantly 
lighter and compact at 0.54kg and 
35mm x 67mm x 167mm. The separate 
battery weighs in at 1.2kg and measures 
170mm x 88mm x 61mm. 

8.1.2.2 Connectivity

The scanner seems to be more user 
friendly, with an integrated touch screen 
for access to the control panel and instant 
previews of the scanned images. 

The scanner can also be controlled 
remotely over WLAN (wireless) and 
Ethernet (wired) and features two USB 
ports for the addition of storage media 
to store the scanned data. 

8.1.2.3 Export Formats 

The scanner supports standard ASCII 
formats, OSF, PTG and ASTM-E57 for 
the export of the point cloud data. 

The data is exported using the proprietary 
LaserControl software packaged with the 
scanner.

Table 5. Relevant Specifications of Zoller + Fröhlich Imager 5010C Scanner

Type of Instrument Phase Comparison (Phase Shift)

Operating Temperature -10° to +45° C

Laser Class 1

Field of View

  Horizontal 360° (maximum)

  Vertical 320° (maximum)

Scan Range 187.3m

Scan Rate Up to 1.016 million pixels/sec (interpreted as points)

Scan Resolution

  Spot Size At 0.1m range, 3.5mm

  Maximum Angle Res. 100,000 pixels/360° (horizontal & vertical) - Adjustable

Scanning Optics Encapsulated Rotating Mirror

Scanner Drive Unspecified, but device rotates along vertical axis

Power Supply 24V

Power Consumption <65W avg.

Note: More specifications can be found on the Zoller + Fröhlich specifications list.

Figure 49.              Source: Leica Geosystems 

Figure 50.                   Source: Z+F Imaging

Figure 51. Z+F Display. Source: anonimou 
(Forum Post)

Figure 52. Z+F Pointcloud Sample. Source: Santoku



41 42

8.2 3D PRINTERS

Two different 3D printers were used 
for the duration of this project. The 
first option was a Form 1+ SLA 
(Stereolithography) printer from 
Formlabs available in the Building 
Technology faculty. The second option 
was an Ultimaker 2+ Extended FDM 
(Fused Deposition Modeling) printer 
(the standard version was also available) 
in the Architecture faculty modeling 
hall. 

8.2.1 Formlabs Form 1+

The Form 1+ is a stereolithography 
printer (see technology overview section) 
which can print objects using propriety 
photo-polymer resins within a resolution 
range of 25 - 200 microns (0.025 - 
0.2 mm) and a relatively fast rate (as 
compared to FDM printers).

The printer has a relatively small build 
volume of 125×125×165 mm however. 
The printer has a USB interface and 
using the Preform software provided 
with the product for the placement and 
slicing of the models. 

A disadvantage of using this printer 
however is that the packaged software  
(Preform) does not have the capability to 
change the fill density of the object. This 
needs to be done manually via either 
third party software of by removing the 
geometry inside to create a shell structure 
for saving material. 

These shortcomings are made up by its 
high resolution printing capabilities that 
far surpass those of traditional FDM 

3D printers. The printer also prints are 
a relatively fast speeds when compared 
with FDM printers. These two qualities 
combined make it an ideal candidate for 
use with restoration projects. 

The available resins range from standard 
opaque and transparent resins to high 
performance cast-able and dental resins, 
expanding its applications from simple 
manufacturing to medicine.

Some sample 3D prints can be seen in 
the images below.

8.2.2 Ultimaker 2+ 
Extended

The Ultimaker 2+ Extended is a special 
edition of the standard 2+ and features a 
larger build volume of 223 x 223 x 305 
mm, 100mm higher than the standard 
version. The print nozzles are available 
in different sizes, giving the printer the 
ability to print at a high resolution with 

a layer thickness as low as 20 microns. 
The disadvantage being really long print 
times. 

The printer also features a heated build 
plate which can  reach a temperature 
of up to 100°C. Heated build plates 
prevent warping of the geometry (which 
occurs due to shrinkage while cooling) 
by keeping the extruded filament warm 
during the printing process.

The Ultimaker 2+ Extended supports 
ABS, PLA and CPE polymer filaments 
(as does the standard version) and 
comes packaged with a free software 
called Cura, which unlike Preform from 
Formlabs, has the ability to reduce the 
fill density of the prints. 

Lower fill densities drastically lower 
material usage and print time at the 
cost of structural strength. The variation 
in fill density is achieved by modifying 
the resolution of the internal rectilinear 
lattice generated by the program. Cura 
only offers one infill pattern however 
but due to the open source nature of 
Ultimaker printers, third party packages 
can be used to change the infill patterns.

The extended size of this version of the 
Ultimaker 2+ makes it a good candidate 
for use with restoration applications. 
A sample 3D print can be seen in the 
image below.

9.1 VAN MILT 
RESTAURATEURS

INTERVIEWEE: HUGO VAN MILT

Restoration Architect & Manager at Van 
Milt Restorers

LOCATION: LUNTEREN, GL, NL

Could you give some context about 
your company and your role in within 
it?

“Van Milt is a restoration company 
and we have existed for 30 years now. 
My father founded the company and I 
joined around 16 years ago and now I 
am the leader of the pack. I think of how 
things work and how to guide and start 
the projects to make sure it is a success 
for all the parties. 

In restoration, we now know that there 
are a lot of developments going on. Laser 
scanning is not new to me, I know it’s 
been going on, but what you’re working 
on is different. I will show you later.” 

How often do you make use of Digital 
Fabrication in your line of work?

“We produce our own stones, specially 
formed bricks, we call them ‘profiel 
stenen’. We use a 3d scanner to scan 
them and then make a mold to produce 
the stones. It’s not a very big market for 
us so we do it sometimes but not all the 
time.” 

Do you employ a team of craftsmen for 
the production or do you outsource it?

“Yes, we do. I will show you their work 
downstairs.”

Do you think new technologies can 
replace the craftsman in the near 
future, especially if the results are 
identical?

“It’s not going to replace them since 
there will always be a need for a good 
craftsman, but I think in some cases the 
craftsman can be replaced. 

You have these machines that cut the 
stone, you put instructions in the 
computer and the machine carries them 
out but it does not look at the quality 
of the stone. If there is a little crack in 
the stone it just continues and breaks the 
stone. A craftsman can see the crack and 
avoid it. 

Maybe in the future there is a machine 
like a 3d scanner that can scan the stone 
before it is worked on. Even today a 
lot of people are out of work because 
of these CNC machines but there will 
always be special projects where you will 
need them. I think it’s a new market and 
will continue expanding in the field of 
restoration. We haven’t used 3d printing 
in any of our projects yet because we 
have a lot of trouble finding the correct 
materials to make our products with. 

We do really traditional restoration 
and one of the reasons for that is that 
if we go to the ‘monumentenzorg’ (the 
service responsible for the maintenance 
of monuments) and tell them that we’re 
going to use 3d printing they’ll tell use 
that that’s not going to happen since 
they want exactly the same materials 
and techniques involved in the original 

Multiple professionals in the field 
of architectural restoration were 
interviewed to gain subjective insights 
into the future of digital fabrication and 
their point of view regarding the use of 
technology in the field of conservation.

9. EXPERT OPINIONS

Figure 53.                       Source: Formlabs

Figure 54. Flexible Sample    Source: Formlabs

Figure 55. Dental Samples    Source: Formlabs

Figure 56.                        Source: Ultimaker

Figure 57. Ultimaker Sample. 
Source: Printer 3D Review

Figure 58. Crafted head in van Milt basement. Source: Author

Figure 59. Fabricated facade element from BK City. Source: Author
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project. But perhaps this will change 
in the next 20 years as the technology 
evolves.”

What are the shortcomings that you 
would expect with digital fabrication?

“I think it makes everything too 
easy, everything becomes some kind 
of Disneyland, where everyone can 
produce anything with their 3d printer. I 
would not find it ideal when for example 
a limestone ornament is replaced with 
printed gypsum and painted. Even 
though you can’t see the difference we 
all know it is fake. Some objects could 
be made hollow, while you don’t see the 
difference, when you knock on it, you 
can feel it.

I think then the monument is fake. If 
you replace the Eiffel tower with a plastic 
replica, it is still the Eiffel tower but it’s 
not real.”

What are your views on the restoration 
of the Parthenon?

“I’m not saying I don’t like it. If you go 
to Belgium or France for example, they 
have a different way of restoration, they 
have a preference for cleaning the existing 
heritage and if something is too old they 
just replace it. I don’t really mind that 
but in some cases, I don’t agree with it 
since people assume something is old 
while it really isn’t.”

Would you consider investing 
in in-house Digital Fabrication 
technologies?

“Sure, we would use it. That’s an option.”

What development do you think would 
convince the restoration industry to 
switch to digital fabrication?

“If the machine can use the material that 
we are allowed to use for restoration then 
I think that’s the main factor that would 
convince us.” 

Do you think the use of technology 
affects the authenticity of a restoration 
if the end result is the same?

“In such a case, I think it makes no 
difference.”

9.3 DRS. HENDRIK-JAN 
TOLBOOM 

Natural Stone Specialist at Cultural 
Heritage Agency (Rijksdienst voor het 

cultureel erfgoed)

LOCATION: AMERSFOORT, NL

In the future do you think the 
craftsman will be completely replaced?

“I think there will always be in the need 
of the creativeness of the human being, 
the machine will not design for you. You 
have to decide what the machine makes. 
I don’t think that’s a big problem though.

Craftsmen will change, their techniques 
will change, their tools will change but 
they will still be craftsmen. They they 

9.2 PROF. IR. ROB VAN 
HEES

Professor of Heritage & Technology, 
Conservationist and Researcher

LOCATION: DELFT, NL

Do you think that Digital Fabrication 
technologies can replace the role of 
the traditional craftsman in the near 
future?

“I expect the traditional craftsman to be 
important for the final touch: there is 
an analogy nowadays with laser guided 
machines for elaboration of natural 
stone.  Too perfect may become ‘visible’; 
there is a fascination in imperfection or 
rather ‘just-not-perfect’ which can not 
be replaced by a machine.”

Which technologies do you currently 
make use of?

“Photography, making hand-drawings, 
analysis of material properties (LDT - 
Laboratory Developed Tests), analysis 
(NDT - Non-destructive Testing 
and LDT) of on-going degradation 
processes.”

Could you give an example of an 
instance during a restoration project 
where digital fabrication may have 
been very useful?

“Making copies of carvings that got lost 
during earthquakes and where apart 
from photos only fragments are left.”

What kind of shortcomings to do 
you expect from digital fabrication 
technologies if they are used in their 
current state?

“Limited availability of different 
materials, adapted to, compatible with 
the existing materials; too high degree of 
perfection.

Furthermore, the limited possibility of 
variation in material properties: physical 
properties like pore-size distribution, 
mineralogy and chemical properties.”

Would you consider investing in these 
technologies for in-house applications?

“If by in-house you mean in the 
university then yes because research and 
innovation are certainly possible related 
to this technology.”

What changes are necessary for 
industry wide adoption of Digital 
Fabrication technologies?

“Broader choice of different materials 
and material properties.”

In what way do you think that the use 
of technology affects the authenticity 
of the restoration?

“There is a risk of there being too much 
perfection, as discussed earlier.”

don’t, then we will have a problem. A 
craftsman is person that can handle 
techniques.

One of the strongest arguments in favour 
of digital fabrication is that working 
with stone can product particles that are 
not very healthy for the people working, 
that’s something that the machines will 
nullify, as well as the fact that they can 
run all day.”

A lot of people argue that the touch 
of the hand has a significance. Do you 
think its just sentiment?

“The interesting thing is that there are 
some surfaces that are very hard to make 
by machine but very easy by hand, then 
in the future we’ll have to ask ourselves 
how hard is it for us to accept the 
structure that the machine makes.

Yes but it’s also an aesthetic question, 
to put new and old together, and do we 
accept the structure that the machine 
makes or the one made by hand tools. 
So that’s a difficult question, its only 
good that we become conscious of this 
problem, more than we do now because 
at this moment we are using machines 
and then afterwards we’re using hand 
tools more or less to cover up the 
machined surfaces.”

What kind of technologies are you 
using in your line of work?

“We use CNC machines and 3D 
scanning. We don’t use 3D printing 
because the materials currently available 
are not useful to us as replacement 
materials. 

We use 3d printing to make models 
of course but not for making the final 
product. I use natural stone and you 
cannot print natural stone.”

What about emulated materials like 
ground sandstone suspended in resin 
that can be 3d printed?

“I think we cannot use that in an 
environment outside exposed to the 
elements, these materials are for indoor 
use.”

Why do you think that when restoring 
damaged ornaments, the preferable 
method right now is to replace the 
entire element by CNC milling a 
replica instead of just replacing the 
missing fragments?

“That depends on the type of stone 
amongst other things. When we replace 
something, if you can replace the parts, 
of course we can do it but in a lot of 
cases, what is left over is hardly use-able.”

What changes would you like to see in 
the future?

“I think there’s still room for more 
accuracy with regards to CNC milling 
but for printing of course there’s a 
limitation of materials. The problem 
being that with 3D printing, we have 
to use mortars for restoration. There 
was a preference for mortars in the past 
because of the absence of CNC milling. 
Nowadays, we can CNC mill stone, it’s 
a more attractive option for use since we 
can use the same natural stone as used in 
the past.”

Do you think that the use of 
technology affects the authenticity 
of a restoration? For example, would 
something hand made have more value 
than something machine-made?

“I wouldn’t say that. However way 
something is made it is always a product 
of the time. If a craftsman makes 
something right now, it is the product 
of the current time, when a machine 
makes it, its the same principle. The 
only question being, is it more or less 
authentic? 

When we look at ‘traditional’ stone-
masonry nowadays for instance we 
see that modern machines are used 
everywhere for all kinds of applications. 
So, in a way I think it has gone too far. 
People don’t understand the process in 
some instances, you cannot tell how 
something was made, they only notice 
it when they’re told. It’s hard to say 
what’s better or worse. Are these changes 
positive or negative? That’s a question 
you cannot answer that easily.”

Do you have any examples of on-
going projects which warrant the use 
of technology but current technology 
hasn’t quite caught up fast enough yet?

“On some chimneys, you can have 
really fine engravings in white marble. 
These engravings cannot be recreated as 
finely as they were in the past. We’ve lost 
the techniques for making these really 
detailed pieces. Current machines do 
not have the sensitivity to produce such 
work.”

What is your opinion on patching 
ornaments with un-weathered pieces 
with sharp edges, as in the Parthenon 
restoration, versus adding weathered 
pieces to create a more seamless 
experience?

“This is always an issue. For example, in 
England, they tend to create new pieces 
with artificial weathering because they’re 
concerned that by slowly introducing 
new pieces into a structure, you can 
lose the overall form. With regards 
to the Parthenon restoration, I think 
the additions are too sharp, when a 
stonemason makes something by hand, 
there’s always imperfections, some of 
them intentional. When something is 
too new or too sharp, it is noticeable.”
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10. TEST CANDIDATES

10.1 DAMAGED STONE 
COLUMN SEGMENT

Location Dept. of Arch., TU Delft

Material Belgian Blue Limestone

Function Column (possibly mullion)

Intervention Replacing missing geometry

One of the two candidates initially 
selected for tests using Digital Fabrication 
is a stone segment from a column found 
in an archive in the basement of the 
Faculty of Architecture (BK City) at TU 
Delft maintained by the Heritage and 
Architecture faculty. 

Most of the artefacts stored in the archive 
have little to no origin information 
available so conjecture has to be made 
regarding their origin and nature.

10.1.1 Material

With help from Rob van Hees, a 
restoration specialist in the faculty with 
expertise in material, an acid drop test 
was performed on the stone surface. 
The effervescence (bubbles) produced 
signified that the stone composed 
of calcite (a carbonate mineral) with 
the bubbles produced caused  by the 
production of Carbon Dioxide which 
occurs when carbonates react with acids.  
The column segment could therefore 
possibly be composed of limestone.

This test isn’t very conclusive since 
many different kinds of stones can 
contain calcites or other carbonates. 
It does rule out non-carbonate based 
minerals however. Conjecture led to the 
deduction that it is possibly composed of 
dense Belgian Blue Limestone because of 
its shade and the region it was found in.

10.1.2 Morphology and 
Function

The presence of long vertical recesses on 
either side of the column segment suggest 
that they were indents for the insertion 
of window frames (possibly a mullion). 

Judging from the style and colouring of 
the column it can be reasoned that it was 
possibly a part from a church building. 

Variation in erosion on either side of the  
stone (one more than the other) gives 
insight into the orientation of the stone. 
The more eroded side could either have 
been oriented towards the outside with 
environmental elements causing the 
erosion or it could have been oriented 
inwards, located at a lower level with 
the erosion being caused by continuous 
haptic contact with the inhabitants of 
the building. 

10.1.3 Restoration Target

The column segment has a considerable 
missing fragment, possibly caused by 
mechanical damage since it is unlikely 
that such extensive damage occurred 
because of natural occurrences (especially 
due to the region not being a major 
seismic zone). 

The fracture surface has quite intricate 
details requiring the need for high 
resolution scanning. Apart from some 
small missing segments and eroded paint 
and corners, no other extensive signs of 
damage could be noted.

10.1.4 Selection Criteria

Two major features contributed to 
the selection of the column as the test 
candidate: it featured symmetricity (had 
symmetrical geometry) which would 
aid during the 3D interpolation of the 
missing fragment and it was readily 
accessible. The latter was a factor due 
to the proof of concept nature of the 
research.

Figure 63. Fracture surface. Credit: Marcel 

Bilow

Figure 66. Faded surface coloration.
Source: Author

Figure 69. Fracture surface on top. Source: Author Figure 70. Linear indentation on vertical surface. Source: Author

Figure 67. Linear surface indentations on the torus. 
Source: Author

Figure 68. Column profile with possible window frame 
indentations. Source: Author

Figure 64. Close-up of fracture surface, 
the high frequency detail is visible. 
Source: Author

Figure 65. Close-up of surface linear indentations. 

Source: Author

Figure 60.  	            Source: Author

Figure 61.  	             Source: Author Figure 62. 	             Source: Author

Experimentation, Failures and Compromises
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10.1.5 3D Scanning

The 3d scanning for the project was 
aided by a Delft based company called 
Delfttech. It was determined that for the 
kind of geometry to be scanned, it would 
be ideal to use the Phase Difference based 
Zoller + Fröhlich Imager 5010C scanner. 

The scans were carried out in an 
improvised setup prepared inside a 
room in the Architectural Engineering 
and Technology faculty. The column 
fragment was placed on an elevated 
platform for better exposure to the laser 
scanner. Six printed reference targets 

were used to orient the laser scanner in 
the room, as depicted in the adjacent 
photograph. Generally, reference spheres 
can be used for laser scanning but 
printed markers are preferable if flat 
vertical surfaces like walls are available. 

The scans were performed with the 
apparatus set to ‘normal quality’ and high 
resolution. These settings were chosen 
on the recommendation of the scan 
operator by considering parameters like 
time spent per scan, final data size and 
the complexity of the geometry. Seven 
scans were performed at intermittent 

intervals around the column fragment. 
Each scan took 3.5 minutes without 
color capture and 7.5 minutes with color 
capture. These scans were then stitched 
via the scanner firmware into one 
cohesive point cloud with the reference 
markers providing a fixed coordinate 
system for the stitching. 

The point clouds were exported in 
.xyz and .pts formats for maximum 
compatibility. The point clouds were 
previewed in Autodesk Recap and then 
exported into the .asc format to be later 
imported for meshing.

10.1.6 Mesh Generation

Multiple software packages were 
experimented with for the optimum 
meshing results. The most important 
aspect of the meshing was to find a 
balance between noise control and 
retaining high frequency details. 

All laser scanning data has a certain 
degree of noise that comes with the 
point cloud. This noise generally follows 
a regular distribution, making it possible 
to remove it during the meshing process 
using specific de-noising algorithms.

During the research, multiple de-noising 
methods were experimented with via 
different software packages to find the 
optimum result. Eventually, the mesh 
exported from the open source mesh 
processing software CloudCompare was 
used.

10.1.6.1 System Specifications

One of the major bottlenecks in the 
meshing process are the specifications of 
the computer system that the meshing 
is being performed on, the RAM in 
particular. For this project, the meshing 
was performed on a Lenovo Y700 laptop  
with an Intel Core i7-6700 HQ 2.6 GHz 
processor and 8 Gigabytes of DDR5 
RAM, running the Microsoft Windows 
10 64 Bit operating system.

10.1.6.2 Poisson Surface 
Reconstruction

The first meshing tests were performed 
on another open source mesh processing 
software called Meshlab. The Poisson 
Surface Reconstruction method was 
used with both CloudCompare and 
Meshlab. This method interpolates 
surfaces using a best fit method via the 
Poisson algorithm. The following figure  
from Microsoft Research shows a 2D 
simplification of the mechanism:

There are three important parameters 
that need to be taken into account 

during the generation of a Poisson mesh, 
these are the Octree Depth, Solver 
Divide and Samples per Node. 

Octree Depth

The octree depth determines the 
resolution of the three dimensional grid 
within which the meshing calculations 
are performed, lower values give low-
poly results while higher values result in 
more detail up till a certain point after 
which it gives diminishing results. Each 
increase in value divides the enclosing 
cubic grid by 8.

The optimum octree depth is dependent 
upon the density of the point cloud 
from the scans. An optimum value of 
12 is recommended by the authors of 
Meshlab for high resolution scans. This 
value was also found to be optimum for 
the column mesh, higher values beyond 
14 failed to provide any extra details and 
often resulted in insufficient memory.

Solver Divide

This parameter determines the iterations 
(or depth) of the calculations, lower 
values help control memory usage. 
A value of 7 is recommended by the 
authors of Meshlab (default value is 8). 

Samples per Node

This value determines the number of 
points to be used in the calculations per 
node. It can be used to exclude isolated  
or anomalous points thereby smoothing 
the resulting mesh. 

It can be used to control noise levels 
during the mesh, reducing dependence 
on noise reduction algorithms in post 
production. The authors of Meshlab 
recommend values from 1 - 5 for 

noise-free samples and 15 - 20 for high 
noise samples. Illustrated below is the 
smoothing that occur by varying the 
samples per node.

SPN 1

SPN 15

SPN 5

SPN 20

Computing Normals

Before any mesh generation process can 
occur, the algorithm needs to know the 
orientation of the normals to determine 
which way the newly generated surface 
should face. Mesh surfaces only have one 
side so the orientation of the normals 
is important for proper meshing. The 
normals are generally computed with 
respect to the shape of the geometry. 
After generation they can often face the 
wrong direction and need to be inverted 
for a usable mesh. 

Figure 71. Printed Reference Markers. Source: Author Figure 72.   Source: Author

Figure 73. Scanning in Progress. Source: Author Figure 74.   Source: Author

Figure 75.   Source: Author Figure 76. Imported Point Cloud.  Source: Author

Figure 77. Poisson Logic. Source: Nader Salman

Figure 78. Standford bunny at Octree 5 

Source: Alexander Agathos

Figure 79. Detail loss with varying SPN
Source: 3D Scan 2.0

Figure 80. Un-oriented (top) and oriented 
(bottom) normals. Source: Stack Overflow
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10.1.7 Mesh Comparison

Since the geometry had to be 
manufactured and had to be 
complementary to the existing fracture 
surface, it was important to retain as 
much detail as possible. This was done 
via trial and error by generating different  
meshes with varying software packages 
and parameters, namely the octree depth 
and samples per node.

10.1.7.1 Meshlab 1.3.3 64 Bit
The first software used for the meshing 
generation was Meshlab. The point cloud 
is first imported into the software and is 
automatically assigned its own layer. The 
normals are first calculated from Filters > 
Point set > Compute normals for point 
set. After the calculation is complete, 
a Poisson mesh can be generated from 
Filters > Remeshing, Simplification and 
Reconstruction > Surface Reconstruction 
Poisson. The meshing parameters are 
then set from the follow dialogue box:

The octree depth was set at 12 (higher 
values would cause an insufficient 
memory error), the solver divide was set 
at 7 and varying values of the samples 
per node were used to find the optimum 
noise to detail ratio. 

A comparison of the meshes generated 
with the original mesh (with samples 
per node set at 1) and the corresponding 
values can be seen in the adjacent figures. 
Green values indicate the centralized 
displacement of the mesh. It can be seen 
that at a SPN value of 20, the  mesh is 

the smoothest and displacement starts 
to affect the fracture surface, which 
would have an effect on the fitting 
of the manufactured fragment.  The 
average displacement remained quite 
unpredictable however. A value of 15 
was selected as a compromise between 
noise and detail and was exported in the 
PLY format for further processing with 
Geomagic Wrap. When the mesh was 
compared with the existing stone surface 
it was found that the laser scanner had 
failed to capture the  horizontal and 
vertical engravings on the surface. This 
can possibly attributed to the limitations 
of the scanning technology (perhaps the 
minimum spot size of 3.5 mm). Meshlab 
was eventually abandoned in favour of 
CloudCompare due to the inconsistent 
results that it was providing (the meshing 
would intermittently fail, leaving a 
bizarre looking unwrapped mesh, as 
pictured). Another reason for not using 

Meshlab for the final manufacturing 
was the limitation of not being able to 
increase the octree depth further than 12 
due to inefficient memory management, 
this was not found to be a problem in 
CloudCompare. The exported mesh 
was still processed in Geomagic Wrap 
however and a 3D prototype was 
produced, the results of which can be 
seen in the interpolation section. Other 
insight gained from Meshlab included 
recording the difference between varying 
values of SPN and their effect on the 
mesh.

Samples per node: 1 Samples per node: 4 Samples per node: 15 Samples per node: 20

10.1.7.2 CloudCompare 
2.6.2 64 Bit

The final meshing was done on 
CloudCompare due to its superior 
memory management capabilities. 
Specifically for increasing the octree 
depth, despite the fact that values beyond 
12 displayed little gain in detail, the gain 
was found not to be negligible. Another 
reason to use CloudCompare was that it 
gave consistent results and the meshing 
was successful a majority of the time. 
Meshlab still gives the user more control 
over the meshing process and multiple 
meshing options however.

CloudCompare does not feature a native 
Poisson meshing algorithm but it does 
come packaged with a powerful plugin 
that does the Poisson meshing. The 
following workflow was performed:

1. Importing the Point Cloud

There is no limitation to the kind of 
point clouds that can be imported into 
CloudCompare, it supports both ASCII 
formats and non-ASCII formats. The 
cloud can be imported via: File > Open 
> Location of point cloud file. The 
.pts format was used for this particular 
project.

2. Cleaning of Point Cloud

It is a good practice to remove statistical 
anomalies from the point cloud so that 
errors during meshing are minimized. 
The SOR filter (Statistical Outlier 
Removal) tool from CloudCompare can 
help remove any points that don’t lie 

within the statistically probably range. 
This tool can be accessed from: Tools > 
Clean > SOR Filter The default values 
were used with good results.

3. Computation of Normals

It is essential for the normals to be 
computed before the meshing can begin. 
This step cannot be skipped. The normals 
can be computed from: Edit > Normals 
> Compute A quadratic local surface 
method proved to give consistent results.

4. Generation of Mesh

Once the point cloud has been prepared, 
the mesh generation plugin can be used, 
which is accessed from: Plugins > Poisson 
Surface Reconstruction> Advanced. 

Since CloudCompare manages memory 
more efficiently than Meshlab, higher 
octree depth values can be used, very 
high values can tend to increase the 
generation time quite drastically 
however. The initial values were set using 
the lessons learned from Meshlab, and 
two meshes with generated using 
different octree depth and samples per 
point values. The first mesh with an OD 
of 15 and SPN of 10 and the second 
with an OD of 16 and SPN of 8. The 
OD:16- SPN:8 mesh (pictured below) 
was finally chosen as a compromise 
between noise and detail. The retained 
noise could potentially also help 
accentuate the character of stone in the 
final casting.

5. Exporting the Mesh

The mesh needed to be exported in a 
format that was readable by Geomagic  
Wrap, which was used for generating the 
missing geometry (interpolation). The 
PLY ( Polygon File Format) was chosen 
for the exporting because of its ability to 
store surface normals and coordinates.

Figure 81. Geometric variation with samples per node. Source: Author

Figure 82. Failed Meshing. Source: Author
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10.1.7.1 Geomagic Wrap 
2015

Geomagic Wrap is part of a series of 
tools from US based 3D Systems. It is 
a software package specifically designed 
for processing and editing 3D scan 
data. Since it is retail and not provided 
by the TU Delft software repository, an 
extended trial license was requested and 
from the 3D Systems sales department 
for the duration of the project.

Compared to other mesh processing 
software, Geomagic provides less mesh 
processing options but is more user 
friendly. It is packaged with the ‘Wrap’ 
mesh processing algorithm developed 
by Herbert Edelsbrunner , there are 
less assumptions in the processing, with 
the effect that there is less extrapolation 
of data(Ramos & Sadri, 2007). This is 
one of the reasons that once the mesh 
is processed in Geomagic Wrap it is 
possible to find holes in the geometry 
which need to be patched subsequently. 

The workflow for mesh processing in 
Geomagic Wrap is as follows:

1. Importing the Point Cloud

The point cloud can be imported via 
Menu Button > Import > Location of 
point cloud file. Geomagic supports all 
point cloud file formats. The percentage 
of the data to be maintained during data 
reduction processes and the import units 
can be specified from dialogue boxes 
before the importation completes.

2. Computation of Normals

The normals can be computed via 
Shading > Repair Normals > Recompute 
Normals from the toolbar (the point 
cloud has to remain selected).

3. Generation of Mesh

The mesh can then be generated by 
clicking on the ‘Wrap’ button on the 
toolbar. For this project, the noise 
reduction at this stage was kept to a 
minimum to give more control at a later 
stage if required. ‘Keep original data’ was 
kept activated in case more meshes 
needed to be generated from the point 
cloud. The sampling was kept at 
maximum quality to generate the most 
detailed mesh. 

The generated mesh had 2.9 million 
polygons, but that was mostly because 
of noise. The mesh had multiple holes 
which could be later patched but there 
was a risk that this would have an effect 
on the fracture geometry, which would 
have consequences at a later stage.

The mesh fixing features of Geomagic 
Wrap will be discussed in the 
interpolation section.

Figure 89. Generated Mesh and Holes. 

Source: Author

Figure 90. The Geomagic Wrap interface

Detail Comparison

Figure 91. Top of Column - Most of the indentations on the surface were lost.

Figure 92. Fracture Surface - Loss of high frequency detail due to noise control is evident.

Figure 93. Torus - Linear indentations on the surface were lost.
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10.1.8 Mesh Interpolation 
Principle (Generation of Missing 

Geometry)

Each type of geometry requires a different 
approach for the generation of missing 
fragments, depending upon factors like 
symmetricity, repetition of geometry and 
the complexity of the fracture surface.

For the column fragment in this case, 
there were two possible approaches, the 
first one being extracting the fracture 
surface polygons and the mirrored 
geometry from the other side and 
stitching the vertices together. Since the 
geometry is quite complex with hundreds 
of thousands of vertices, this process 
would have been quite cumbersome.

The second approach was the Boolean 
approach. In polygonal modeling, 
Booleans operations generally subtract, 
intersect, merge or split overlapping 
meshes by detecting geometry that 
lies within or outside the overlapping 
sections. The method employed for 
the column segment is described in the 
adjacent figures.

Since the object in question is hand-
crafted, perfect booleans cannot be 
achieved and there would also be 
extra surfaces present, requiring post-
processing.

1. Identification

If the geometry exhibits symmetricity 
like the column fragment, it is possible 
to use the symmetrical data to predict or 
‘interpolate’ the missing sections using 
boolean operations. While efficient for 
perfectly geometrical meshes, it can 
become a problem with laser scanned 
data, particularly if the scans are of hand 
crafted geometry, as will be discussed 
later.

2a - 2b. Mirroring or Rotating

There are two possible options for 
orientating the geometry for the boolean 
operations. The selection should ideally 
be on the basis of which orientation 
provides the best coverage of the mesh. 

However, it can be postulated that there 
could be subtle differences between the 
right and the left hand side when it comes 
to hand-crafted objects because the tool 
in contact with the object is usually held 
in the non-dominant hand independent 
of which side is being crafted. Mirroring 
takes into account this possibility. 

It is also possible however that for 
smaller objects, the craftsperson changes 
their direction of approach for the other 
side, inverting the sides, in which case 
rotation would be preferable.

3. Alignment

For perfectly geometrical mirrored or 
rotated volumes, alignment is not a 
problem but for hand-crafted objects, 
symmetricity depends upon the skill of 
the craftsman. The two objects (original 
and mirrored/rotated) need to be aligned 
using features on the surface as references 
for the boolean to occur perfectly.

4. Boolean Operations

In this instance, the missing geometry 
can be generated via a subtractive 
boolean operation that removes the 
overlapping geometry and just leaves 
the missing components. As mentioned 
earlier, this boolean would not be perfect 
because the hand-crafted nature of the 
object and would require extensive post-
processing subsequently.

Interpolation using Boolean 
Operations

1

3

4

2a

2b

Expectation

Reality

10.1.9 Mesh Manipulation 
& Interpolation 
(Geomagic Wrap)

The Boolean capabilities of multiple 
software packages was experimented 
with before Geomagic Wrap was selected 
as the primary mesh editing software. 

Autodesk 3dsmax failed to give results 
despite taking a considerable amount of 
time for the boolean calculations. 

Rhino 3d did provide a use-able boolean  
(pictured below) however but only 
after the mesh was decimated to about 
50% of the original polygons, causing a 
considerable loss of detail on the fracture 
surface. Without the decimation, the 
boolean operations would fail.

The final mesh was not generated 
on Geomagic Wrap but rather on 
CloudCompare, as discussed earlier. 
Geomagic Wrap’s superior mesh editing 
tools however still warranted its use.

Geomagic Wrap’s Mesh Doctor (used for 
repairing imperfect meshes, removing 
spikes, holes and self intersections for 
example), Remesh tool (for creating a 
more uniform tessellation of polygons) 
and knife sculpting tools (for slicing 
and removing unwanted sections of the 
mesh) were indispensable during the 
duration of this project.

10.9.1 Manipulation in Geomagic Wrap (step by step)

1.  Importing the Mesh

The mesh, earlier exported from CloudCompare as a .PLY file can be imported via 
Menu button > Import > Location of mesh. Millimeters were selected as the import unit 
since those were the units CloudCompare was operating with. 

The imported mesh (Octree value of 16 and 8 samples per node) had a polygon count 
of  641, 606. While on the higher side, it was still sufficient for most 3D printers to 
process (which can make use of up to 1 million polygons per model).

2. Alignment with the Coordinate System

After importing, the mesh was aligned with the local coordinate system for easier 
manipulation of the subject and mirroring. 

The transformation was done using the Transform tool (Tools > Transform > Edit). 
Since the object is not perfectly geometrical, the transformation was performed visually, 
with the elongated side aligned with the x-axis.

3. Cropping Unnecessary Data

For the boolean operation, only the fracture surface and the geometry opposite was 
required, therefore the geometry immediately below the torus was cropped off using the 
Trim with Plane tool (Polygons > Trim > Trim with Plane), with the geometry trimmed 
using the XY System Plane. The intersection was then closed off using the same tool. 

The cropping was performed to save time during the boolean process and avoiding 
the intersection of unnecessary geometry. The torus and some other features were left 
un-cropped so that they could be used as references while aligning the two mirrored 
geometries.
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4. Mirroring

Since the model was already aligned with the local axes, the mesh was mirrored using the 
YZ system plane via the Mirror Tool (Tools > Mirror).

4. Aligning the Meshes

The two meshes (mirrored and original) were aligned with respect to the geometry that 
needed to be generated via the boolean operation. This was done with the aid of the 
recognizable features that were present on the geometry, such as the vertical recessions 
and tori. This also needed to be done visually to achieve maximum overlap of the surfaces 
to provide the most accurate boolean. Again, the Transform tool ((Tools > Transform > 
Edit) was used for the incremental transformation. 

5. Boolean Operation

A subtract boolean operation was performed with the two meshes selected from Polygons 
> Boolean > Subtract 1 or 2 (any since the meshes are duplicates). The mesh result was 
not perfect and was cleaned up in subsequent steps.

6. Cleaning the Mesh

Because of the geometry being hand crafted (as mentioned earlier), the imperfections 
in the sculpted piece were made evident after the boolean, some of it may also be 
due to errors in the alignment of the meshes (since it was performed visually). These 
imperfections can be cleaned using an array of tools available within Geomagic Wrap. 

The mesh was first passed through Mesh Doctor, an automated tool that detects highly 
creased edges, spikes (sudden extreme jumps in geometry, possibly caused by noise), and  
self-intersections. Mesh Doctor can be accessed from Polygons > Mesh Doctor. After the 
processing, most of the troublesome and isolated geometry was automatically removed. 

The remaining isolated geometry was selected and removed using the Lasso tool (Select 
> Selection Tools > Lasso). It should be ensured that the selection mode is set to ‘select 
through’ to ensure all of the geometry is selected.

The attached geometry was then removed using the Trim with Sheet tool (Polygons > 
Trim >  Trim with Sheet). This tool projects a sheet referenced from a manually drawn 
curve parallel to the line of sight of the viewport. The viewport had to be rotated multiple 
times to get the best slices. 



57 58

7. Polygon Decimation

Decimation is a technique for reducing the number of polygons in the mesh while 
retaining the general shape of the volume. The reduction in polygons can result in faster 
performance of mesh calculations. 

The decimation tool can be accessed from Polygons > Decimate. To retain the existing 
geometry as much as possible, the Curvature and Mesh Priority were set at Maximum. 
The deviations recorded with the fragment are illustrated in the diagrams below.

50% Triangles		    25% Triangles                       10% Triangles

After experimentation, it was decided to skip decimation for the final model to avoid 
any possible loss of geometry due to the amount of accuracy required for the process. 
However, in certain cases (when the number of polygons exceeds 1 million, for example) 
decimation would be required. The un-decimated mesh and the fracture geometry were 
then exported in .PLY format for sculpting in Geomagic Freeform Plus.

 
10.9.2 Sculpting in Geomagic Freeform Plus and finishing in 

Geomagic Wrap

For the project, a 15 day trial version of Geomagic Freeform 
Plus was used to remove unneeded geometries that could not 
be achieved using the Geomagic Wrap trim tools or boolean 
operations. 

The geometry was reimported into Geomagic Wrap to fix 
discrepancies however. Freeform is a sculpting tool which can 
be used in conjunction with graphics tablets or ideally haptic 
devices from Geomagic which provide contact feedback. For 
this project, a Wacom Intuos 4 graphics tablet was used for 
the sculpting.

1. Importing the Mesh

The mesh was imported into Freeform Plus via File > Import Model > Location of Mesh. 
The object was imported as a mesh but needed to be converted to clay for the sculpting 
tools to work.

2. Conversion to Clay 

The mesh was then converted to clay as a copy via the context menu on the object list, 
which can be accessed from Right Click > Mesh Utilities  > Copy to Clay. This creates a 
‘clay’ copy of the mesh, enabling the sculpting tools. 

‘Clay’ is essentially a conversion of the mesh to ‘voxels’ which are three-dimensional 
representations of geometry in space, like pixels but in three dimensions. This conversion 
helps the software emulate the consistency of clay, making the process of sculpting more 
intuitive, as opposed to meshes which are represented by polygons defined by vertices 
(points in space).

3. Sculpting the Clay

There are multiple sculpting tools that can be utilized in Freeform Plus. Three of the 
sculpt tools that were primarily used for the removal and adjustment of geometry were  
the Carve, Smudge, Smooth and Hot Wax tools. 

For this project, the carve tool was used to make rough cuts in the new fragment 
geometry along the fracture surface. These cuts were then further defined using the 
smooth tool, this tool also helped avoid the generation of any jagged geometry. The hot 
wax tools were also used on occasion but sparingly due to their rapid deformation of 
the geometry. 

The smooth tool was also used to smooth out any sharp geometry. This was done 
intentionally to make the molding process more streamlined by helping avoid the 
breakage of geometry during casting.

Not all of the sculpting tools were available to use however due to the unavailability of a 
Geomagic Haptic device, which was required for these tools to function.

Another modeling aid was the transparency mode or ‘See through’ mode, accessed from 
Right Click > See Through > Turn on. This helped aid the modeling process by making 
the fracture surface visible, helping make sure that the fragment conformed to its edges 
while modeling.
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4. Conversion to Mesh and Export

After the conclusion of the sculpting, the clay was converted back to a mesh via the 
context menu accessed from Right Click > Clay Utilities  > Copy to Mesh, creating a new 
mesh using the clay as a reference. No loss of detail was noted during the conversions. 
The newly generated mesh was then exported in the .PLY format for further processing 
in Geomagic Wrap via File > Export Model.

5. Finishing in Geomagic Wrap

The mesh was reimported into Wrap and passed through Mesh Doctor again to remove 
any errors in the geometry. 

The surfaces on the top and front of the mesh were flattened to more closely match the 
original stone column. These distortions had occurred earlier during the meshing process 
but were easily fixed using a combination of the Trim with Plane tool and the deletion of 
polygons to create holes which were then filled with the Fill Hole tool (Polygons > Fill 
Single) on the Tangent setting. Some of the sharp edges produced were then smoothed 
out using the Relax tool (Polygons > Relax).

6. Remeshing in Geomagic Wrap

By this point, all the required editing of the mesh had finished. The mesh was then 
Remeshed using the Remesh Tool (Polygons > Remesh) for a more consistent 
distribution of polygons. The ‘Target Edge Length’ value has to be experimented with 
to make sure that there is no loss of geometry during the process, smaller values ensure 
that the smallest details are retained. Remeshing ensures that no problems occur during 
the 3D Printing process. 

Before Remeshing 		              After Remeshing

7. Finalising the Mesh

Finally, a manifold check as performed from Polygons > Manifold > Make Manifold 
(Closed) this makes sure that the mesh is watertight and therefore suitable for 3D 
printing. At this point, the Boolean operation was repeated using the original fractured 
column mesh and the newly generated mesh to make sure that no part of the fracture 
surface had changed. No change was recorded. From this point onwards, the mesh was 
ready to be manufactured.

10.1.10 Manufacturing

Multiple approaches were considered 
for the manufacturing of the missing 
fragment. Some of the factors that were 
considered during the selection of the 
manufacturing technique were:

1. Compatibility of Materials

One of the factors affecting the selection 
of the new material is the physical 
compatibility of that material with the 
existing Belgian limestone. A material 
with different thermal expansion and 
contraction rates for example would not 
be able to bind with the original material  
and cracking would occur. In the case 
of stone, milling techniques would 
provide the possibility of recreating the 
elements in the original stone material 
but at a  much higher cost. Alternatively, 
especially if milling facilities are 
unavailable, castable stone substitutes 
such as concrete (colloquially known as 
liquid stone) could be used.

2. Contrast between Old and New

As discussed in earlier sections, a contrast 
between the existing elements and the 
new restorative elements adds a layer 
of honesty to the restoration. It allows 
the person experiencing the site of built 
heritage to individually determine the 
state of the site before the intervention 
while at the same time get an idea of 
how the site was originally meant to be 
experienced.

This contrast can be approached by using 
a different material than the original, 
creating the missing element with no 
state of wear i.e. in the original state 
(the difference can be appreciated in the 
adjacent images), or offsetting the new 
geometry from the original (as is the case 
with the Parthenon restoration.

3. Availability of Techniques

In war torn regions or the third world, 
there are often minimal cutting edge 
manufacturing technologies readily 
available or importing such technologies 
could incur unplanned costs. In such 
circumstances compromises have to be 
made. These compromises then have an 
effect on the state of the final restoration. 

Option: Creation of new geometry

Following the footsteps of the 
Parthenon restoration, new geometry 
would be easier to manufacture and 
give insight into the original state of 
the structure.

Option: Reusing existing geometry

Compared with using new geometry, 
using the existing geometry has a relatively 
complex workflow but the results would 
be less distracting and would give insight 
into the state the structure would be in 
had it survived without drastic damage 
and just experienced regular wear and 
tear.

Preferential Workflows

For the restoration of the column segment 
there were certain preferential workflows 
that could have been followed. The 
selection of the workflows was decided 
upon considering the aforementioned 
factors. The workflows are as follows in 
order of preference:

1. Direct Multi-axis Milling of Stone

Depending upon whether a conservation 
charter is being followed (such as the 
Burra and Venice charters) there could 
be certain stipulations that may need to 
be enforced. Ideally, the missing stone 
fragment on the column could have been 
manufactured using stone (even the same 
Belgian blue limestone) but due to the 
unavailability of multi-axis stone milling 
equipment and the prohibitive costs of 
commercial options, this workflow was 
discounted. 

2. Casting with Cement

The option to create a mold using a 
digitally fabricated ‘pattern’ or reference 
of the missing geometry was more 
accessible and would possibly achieve 
similar results despite not adhering to 
charter stipulations. 

One risk however was losing detail after 
every stage of the mold making process. 
This loss of detail would be experimented 
with during the prototyping stage. The 
results and workflow options can be seen 
in the prototyping section. 

Casting was eventually chosen as the 
preferable option due to it being more 
accessible combined with the possibility 
of giving usable results with similar 
properties to the original material, and 
the ability to reuse the mold to create a 
variety of prototypes.

3. 3D Printing Concrete

While concrete 3D printing technology 
is still in its infancy, it should be possible 
to get usable results via hybridization 
with other manufacturing technologies. 
An option was to print a rough volume 
of the missing fragment and then finish it 
using a CNC milling machine, refining 
the details. As the technology develops, 
this workflow may be the preferential 
option even without hybridization.
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Chosen Workflow

The final chosen workflow for the 
manufacturing of the missing fragment 
was casting cement. This could be 
done using one of three possible ways, 
using investment casting (lost polymer 
method), creating a silicone negative 
using a 3D printed positive or by directly 
printing the mold.

Investment Casting

The potential investment casting process 
is illustrated in the adjacent diagrams. 
This process was later discarded for 
a number of reasons. The primary 
reason being that since the top of the 
geometry to be manufactured was flat, 
a closed mold was not needed and 
hence the investment casting process 
was unnecessary. Secondly, the leaking 
polymer could potentially damage the 
oven being used and hence required an 
oven dedicated for this process.

Silicone Molding and Casting

3D Printing the mold directly on the 
other hand would also present problems. 
Firstly, the mold would require thick 
walls for reinforcing the poured cement 
and would therefore require a larger 
build volume on the 3D printer as 
compared to just directly printing the 
positive. Build volume being one of the 
major constraints of modern consumer 
polymer 3D printer, this would be 
infeasible. 

Therefore, it was decided to manufacture 
the positive and then create a mold using 
the positive as a reference. This would 
be done by layering (using a brush-able 
silicone mixture) and pouring (using 
a standard molding silicone mixture) 
silicone   around the print, reinforcing 
the silicone mold with either poured 
gypsum or milled wood and then 
removing the printed ‘pattern’ to pour 
the cement. The specifications and ratios 
involved in the process are discussed in 
detail in the prototyping section.

The basic process is illustrated in the 
figures on the next page.

Figure 131. Investment Casting Process (Secondary Workflow)
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Representation of fractured 
stone column 

Manufacturing using SLA 
Printing (alternatively FDM)

Polymer ‘pattern’ is dipped 
in Silica slurry or alterna-

tively stuccoed

The ceramic ‘investment’ 
needs to be dried for 1- 

2 days before use.

The oven is first heated to around 
200°C (for Nylon 6) to remove 

the polymer ‘pattern’ and then at 
900°C for sintering.

The ceramic mold is then 
used to cast the cement 

addition.

Surface replication of 
fracture morphology 

(LIDAR)

Digital modeling of 
fragment

A release agent is applied to the polymer 
pattern surface, and the pattern is held fast 
to the surface using wet clay.

Three layers of mold 
making silicone are 
applied after intermittent 
intervals of 20 minutes.

A split milled MDF mold is used to 
enclose the silicone covered pattern. 
A release agent is applied to the 
MDF before closing.

The mold is clamped and sealed with 
wet clay and more silicone is poured 
into the newly created cavity, till it 
reaches at least 2 cm above the end of 
the 3D printed pattern.

The mold is clamped again and 
a release agent is applied to the 
inner surface of the silicone shell.

A cement mixture is poured into the silicone 
shell ( with gentle shaking to avoid bubbles) 
until it reaches the marked top surface. 

The cured cement positive is removed 
from the mold after 2-3 days.

The silicone is left to cure for 24 
hours and the clay is removed and 
the mold is flipped over to access 
the other end of the pattern for 
extraction.

The MDF mold is released and 
the polymer pattern is manually 
extracted from the silicone shell.

Figure 132. Silicone Molding and Casting Process (Primary Workflow)
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Prototyping

Prototypes were created at various 
stages of the research. One of the first 
3D prints were sections of the missing 
fragment created to test the conforming 
of the processed complementary fracture 
surface on the existing fracture surface  
on the stone. 

The first sample was created at an earlier 
stage using the mesh exported from 
Meshlab (the CloudCompare mesh 
was finally used, due to the ability to 
use a higher octree depth value) using a 
Project 360 a powder based printer using 
a proprietary ‘VisiJet PXL’  gypsum 
based material. The print did conform to 
the fracture surface as pictured but the 
print eroded readily due to the powder 
based nature of the material. Any further 
exploration with this material was 
therefore suspended. Another problem 
was the excess smoothing of the mesh 
exported from Meshlab, particularly the 
vertical filleted corners which seemed to  
have a larger radius that the actual stone. 

Ideally, the final print was to be printed 
using the Form 1+ printer available at 
the AE+T faculty using their proprietary 
clear resin. This printer was chosen due to 
its high speed and resolution capabilities 
as well as providing a relatively smoother 
surface compared to FDM printers. All 
prints were to be printed at 0.1 mm 
as a compromise between detail and 
time. However, the first test print failed 
halfway (as pictured), the problem was 
diagnosed as a faulty resin tank. Part 
of the fracture surface had successfully 
printed and was tested on the stone, 
providing a much better fit as compared 
to the ProJet printer. This seemed to be a 
positive development and it was decided 
to continue using the printer.

The resin tank was replaced and a 3-part 
full scale mesh was modeled, with each 
part fitting inside the build volume of the 
printer. The parts were to be connected 
using three cylindrical insertions with a 
tolerance of 0.1 mm.  Since the Preform 
program did not support reducing the 
fill density, a decimated copy of the 
mesh was offset inwards and subtracted 

from the original mesh to create a shell 
to save material. The first part (bottom 
fragment) failed at the 40% mark. It 
was deduced that the curing laser was 
faulty and further tests were therefore 
suspended. 

Due to these faults, the secondary option 
of using the available FDM printer was 
opted for despite the fact that this choice 
would result in visible lines marking 
the layer thickness on the surface. It is 
possible to smooth the surface either by 
dipping the printed parts in a corrosive 
liquid (tetrahydrofuran for PLA for 
example) or sanding but this would 
result in loss of accuracy and was not 
considered.

The visible lines were not necessarily 
considered to be a setback for the 
process, they could potentially give 
insight into the chosen process for the 
restoration and would communicate 
more information to the viewer. 
Another advantage of using FDM was 
the considerably larger build volume 
available, making it possible to create the 
final print in 2 pieces rather than 3. 

Excess Smoothing

Failed print surface

Figure 134. Three part model with cavity

 for Form 1+ Printer. Source: Author

Scale Model Tests

While the full scale section tests were 
being carried out, experimentation was 
also started on creating a cast at a smaller 
scale. These experiments were performed 
on a 1/3 scale model of the original 
fragment printed in one piece in PLA 
with a layer thickness of 0.1 mm. 

The objective of the tests was to test the 
mold making process, the interaction 
of the mold making materials with the 
printed polymer and finding the right 
mixture and type of cement to cast 
sufficient detail, the right shade and 
strength.

The tests were performed in Stevin Lab II  
of the faculty of Civil Engineering, TU 
Delft under the supervision of Telesilla 
Bristogianni.

The Molding Process

For this project, the Mold Max 30 
series of silicone from Smooth-
on was used for the mold making 
applications.

The silicone kit consists of two 
constituents, a Part A and Part B. 
After Part A has been measured out 
on a scale, Part B, the curing agent 
is added at a 1:10 ratio (measured 
on digital scale) and mixed. The 
standard Mold Max 30 Part B makes 
the silicone suitable for pouring but 
does not have the adhesion required 
for brushing. 

For this project brushing was chosen 
as a necessary measure to capture the 
highest detail possible on the silicone 

and to avoid bubbles that can occur 
during pouring. A different Part B  
(Mold Max Stroke) had to be used 
for the brushing applications. Unlike 
the Mold Max 30 Part B, this Part 
B was colorless and had to be mixed 
longer to ensure that it had mixed 
with all the silicone.

Silicone Specifications

The pattern enclosed from five sides 
with plywood panels (with release agent 
applied to the inner surfaces) which 
were then held together using clamps.

Mixed gypsum (plaster) was then 
poured (1 part water, 2 parts gypsum) 
and the mixture was left to cure for an 
hour.

Holes were dug on the gypsum surface 
to ensure that the two parts of the mold 
would adhere together. A clay funnel 
was created to make room for the 
material to be casted later. 

A release agent was applied 
to the print surface 
(Vaseline, Petroleum Jelly).

The print (pattern) was 
held upright using wet 
clay to start the molding 
process.

The pattern was brushed 
with three layers of 
silicone (using Mold 
Max Stroke Part B).

The enclosed pattern was embedded in 
clay half way to make sure that the poured 
gypsum only covers half of pattern. 
Vaseline was then applied to the clay and 
silicone surfaces as a release agent.

1 2 3 4

5 6 7

Figure 133. Testing Morphologies and Failed Prints. Source: Author
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A gypsum mixture of the same composition 
was poured to create the complementary 
part of the mold. A release agent was 
applied to all exposed surfaces before the 
pouring.

The clamps and plywood 
were removed and the 
mold was inspected.

Due to the nature of the geometry, 
the first method proved unsuccessful. 
Therefore, the brushed silicone was 
removed from the gypsum and a 
cylindrical silicone cushion was cast 
around it (using Mold Max 30 Part B).

A mixture of i.tech Ultracem 52.5 cement 
was poured into the new mold, mixed 
with water with a ratio of 2:1 (two parts 
cement).

The mixture was gently shaken and 
mixed inside the mold to prevent bubbles 
forming inside the mold.

The casted cement broke upon removal. 
It was postulated that this occurred 
because the cement mixture did not 
have enough time to cure.

The cement was casted again but this 
time was left to cure for two days. A 
screw was added to the narrower part as 
a precaution.

The cast was removed successfully in one 
piece but had a cavity at the bottom, 
possibly due to insufficient shaking and 
mixing during pouring.

On this instance, the mold 
was damaged during the 
removal of the 3D print 
pattern but it was still 
usable.

A test gypsum sample 
was cast in the mold, 
unfortunately the mold 
proved to be too stiff and 
the cast was damaged.

Alternative Method

1

4

2 3

Final Production

Since the use of FDM (Fused Deposition  
Modeling) 3D printing technology 
was selected as the primary mode of 
production, the print could now be 
manufactured in two parts due to the 
larger build volume provided by the 
Ultimaker 2+ Extended printer. 

This time, a tolerance of 0.3 mm was 
used for the cylindrical inserts. A higher 
value was used so that small adjustments 
could be made if necessary during the 
glueing process. Like earlier, an extruded 
platform was modeled on top of the 
fragment to create a pouring cavity 
during the production of the mold.

Printing Specifications
The final print was manufactured with a  
layer height of 0.15 mm and a fill density 
of 20% with a print speed of 50 mm/s 
using a standard white PLA filament.

The printing took considerable time 
however, with the top fragment taking 
up to 20 hours and the bottom fragment 
around 12 hours.

Mold Reinforcement
An enclosing box was modeled to save 
material while pouring the silicone shell.  
The box was milled out of MDF and 
would be clamped together during the 
manufacturing process. 

The box consisted of two pieces with 
simplified cavities that conformed to 
the basic shape of the fragment to be 
manufactured but with an offset of 2 cm. 
This would essentially be the thickness of 
the second silicone shell.

Post Processing
Since the 3D printed ‘master’ was going 
to be produced in two pieces, there was 
going to be a joining cavity that could 
potentially be transferred to the mold. 
In view of this, there were two options, 
either to sand it out on the 3D print 
itself or to sand it on the casted cement. 
The latter option was chosen since any 
damage to the master could potentially 
delay the process considerably, whereas 
the cast could just be casted again.

Extruded platform 
for mold

Cylindrical Holes
     = 6.3 mm

Top Fragment

Cylindrical Inserts     = 6 mm
Height =15 mm 

Bottom Fragment

Figure 153. Two part model for Ultimaker 2+ 

Extended Printer. Source: Author

Figure 154. MDF Mold Reinforcement

(All Dimensions in mm)

96.4 

196.65
 

393.26
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The two printed fragment parts did not need an adhesive to be 
joined together and would fit together readily.

Interestingly, because the manufactured fragment fit the stone 
column so accurately, it did not require any adhesion or force 
to be kept in place.

Generation and Alignment of Pattern

1. Although the two components fit 
together readily, PVA white glue was still 
used as a temporary measure in case the 
silicone leaked inside the cavity between 
the two pieces.

4. Progress after first layer. Some excess 
silicone flowed to the bottom of the 
pattern, this excess silicone can be cut off 
once the layers have cured.

5. Progress after second layer. A second 
layer was brushed on after waiting for 
30 minutes so that the viscosity of the 
silicone was increased and the brushing 
action would not cause the first layer to 
come off.

6. Progress after third layer. The 
surface was slightly textured to 
improve adhesion with the silicone 
to be poured later.

2. A thin layer of Vaseline was applied to 
all the exposed surfaces as a release agent 
against the silicone. This also ensures the 
smooth removal of the pattern from the 
mold.

3. The ‘pattern’ was held down using wet 
clay and the first layer of silicone (using 
Mold Max Stroke Part B) was applied to 
the surface.

1

4

2

5

3

6

Transference of Pattern (Mold Production)
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7. The silicone overflow was sliced off 
using a paper cutting knife to ensure that 
there  is room for a layer for clay to hold 
the pattern down.

8. The pattern was then held down using 
wet clay and a thin layer of Vaseline was 
applied to the clay as a release agent. No 
release agent was applied to the silicone 
surface since it had to bind with the 
poured silicone layer.

9. An MDF mold reinforcement was 
CNC milled with an average offset of 2 
cm to aid in the pouring of the secondary 
silicone layer. This MDF container 
would also help strengthen the mold to 
prevent any deformations during the 
casting process.

10. The pattern was placed approximately 
in the middle of the mold reinforcement 
and the setup was clamped shut using 
four bar clamps.

11. The silicone (with Mold Max 30 Part 
B) was slowly poured around the pattern 
to ensure that there are no gaps left 
behind.  Care was also take to ensure that 
the pattern did not move during pouring.

12. The newly poured silicone was then 
left to cure inside the mold reinforcement 
for 24 hours.

7

10 11 12

8 9

13. The setup was disassembled for inspection after the silicone 
had cured. In this instance, the inner surface of the mold 
reinforcement had been contoured to save time but that caused 
difficulties during disassembly, despite the use of a release agent. 
Therefore, it is recommended to mill a smooth surface or to use 
a different material.

15. A layer of Smooth On Universal Mold Release was applied 
and left to dry overnight. Another layer was applied 15 minutes 
before the casting process as instructed by the manufacturers. 

NOTE: Respiratory protection is required if the spray is being 
applied in an unventilated area. 

17. The first cement sample was casted with a water-cement 
(i.tech Ultracem 52.5) ratio of 0.5 and the addition of white 
pigment (Titanium Dioxide) to lighten the color of the cement.

A second sample followed the same ratio but with the addition 
of a bag of fine sand and aggregate (CEN Normsand DIN EN 
196-1) in a mixer to increase strength and durability.

18. Each sample was casted in two sessions, with 600g cement 
and 300g water. The first sample was mixed with no aggregate 
or sand and 10g of white pigment, the second sample used more 
pigment (20g) and 1350g (1 bag) of fine aggregate and sand. 

After pouring halfway, each sample was vibrated for 30 seconds 
for compaction, filled till the end marker and compacted again.

16. The mold setup was placed on a vibrating table to prepare 
for the casting process. The vibrating table helped ensure that no 
bubbles were trapped inside mold. Bubbles can potentially cause 
loss of detail and larger bubbles can result in improper casting.

14. The setup was disassembled for inspection after the silicone 
had cured. In this instance, the inner surface of the mold 
reinforcement had been contoured to save time but that caused 
difficulties during disassembly, despite the use of a release agent. 
Therefore, it is recommended to mill a smooth surface or to use 
a different material.

13 14
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17
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18
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19. The sample was removed after curing 
for 72 hours. A slight incision had to be 
made on the mold to extract the cast, the  
incision would leave minimum marks 
on any subsequent castings due to the 
cohesive properties of silicone.

Fitting of first cast, the seam caused by 
the smoothing of the edges is visible.

Top of the first column segment with 
the first cast, displaying the mirroring of 
the geometry. Small bubbles that escaped 
from the inside of the cast are also visible.

Fitting of the second cast, the lightening 
caused by the doubling of the pigment 
amount is visible.

20. The transferred markings from the 
PLA pattern were then sanded away from 
the casted material using a medium grit 
sandpaper.

A visual comparison of the first cast 
(right) with the PLA pattern (left).

19 20
CW Ratio 0.5 - No Sand or Aggregate 
10g White Pigment

Figure 186. First Cast Photographed by Marcel Bilow



73 74

CW Ratio 0.5 - Fine aggregate and sand

20g White Pigment

Figure 187. Second Cast

10.1.12 Restoration Matrix

10.1.11 Cost Comparison 
(Estimation)

The costs of projects can vary because of  
the economics of scale. Larger projects 
may have one time costs divided over 
multiple cases, lowering the overall cost 
per case. 

In consultation with Hendrik-Jan 
Tolboom, some figures were arrived 
at to estimate the costs that would be 
incurred for the patching of the test case. 
It was determined that the majority of 
the costs would be labor costs, material 
costs for traditional methods would be 
considerably lower. 

The calculations were made assuming 
a specialized stonemason per hour cost 
from 25 to 40 Euros (figures provided 
by Tolboom) in the Netherlands and 
postulating 3 days of work with an 8 hour 
work day. 

The digital fabrication method would 
require at least 5 days since some days 
would need to be dedicated to scanning 
and manufacturing of patterns. However  
a dedicated 3D modeller may  be required 
to model the meshes and the laser 
scanning may need to be outsourced to a 
scanning firm. A pay-scale of a 3D artist 

in the United States can be considered, 
which amounts to 15 to 25 Euros per hour 
(“Payscale,” 2016). An advantage of using 
digital fabrication is that the availability 
of skills is not geographically limited, so 
the pay-scale can vary considerably.  The 
material costs would be higher for the 

digital fabrication method because of 
the newness of the technology but these 
costs may come down over time. Since 
the digital fabrication method required 
the use of silicone molding due to the 
hybridization of the technique, these costs 
will also be added.

Conclusion

While there is a difference in costs 
between the techniques, due to the 
assumptions in the calculations and 
variation in labor costs throughout the 
world, the comparison is inconclusive. 
It has to be noted however, that 3D 

modeling is not limited geographically 
and there is a possibility of outsourcing to 
reduce costs.  Due to these uncertainties, 
it can be concluded that cost comparison 
should not be the primary motivator 
behind pursuing digital fabrication since 
it provides many other advantages. 

Table 6. Costs Lower Estimate Upper Estimate

Traditional Method
(Labor Costs)

25€ x 8 (hours) x 3 (days) =
600€

40€ x 8 (hours) x 3 (days) =
960€

Material Costs 100€ 200€
Production Costs Negligible Negligible

Total Est. Costs 700 - 1160€
Digital Fabrication
(Labor Costs)

15€ x 8 (hours) x 3 (days) =
360€

25 x 8 (hours) x 3 (days) =
600€

Material Costs
20€ (PLA) + 102€ 

(Silicone) + 20€ (MDF) + 
30€ (Cement and Misc)

100€ (PLA-SLA) + 102€ 
(Silicone) + 20€ (MDF) + 
30€ (Cement and Misc)

Production Costs Negligible (in-house)
60€ (3D Printing)  + 20€ 

(Milling)
Total Est. Costs 532 - 932€

Photographed by Marcel Bilow

(Table 7)
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10.2 BOERDERIJ DE 
HAMWONING

Location Rotterdamseweg 155, Delft

Material Unknown Wood

Function Ornamental Relief

Target Angel Relief

Intervention Replacing missing geometry

Style Renaissance Mannerism

Date ~1608 CE

This wooden relief was one of the more 
challenging candidates selected for 
intervention not only due to the kind 
of damage that it had sustained but also 
because of the location of the angel relief 
that was to be scanned. The angel was 
3.6 m above ground and surrounded by 
water from a stream on both sides.

Condition
Initial inspection of wooden fragments 
found near the site revealed that there 
was extensive rot present in the core 
of the wood. This was determined by 
the weight of the pieces which were 
quite light weight, suggesting that the 
rot had eaten away most of the lignin 
or cellulose in the wood. Further tests 
would be needed to determine whether 
it was white, brown or soft rot causing 
the damage and whether any sources of 
moisture would have to be cut off before 
the restoration could begin.

Restoration Approach
There were two ways to approach 
interpolating the missing geometry on 
the angel. The first method involves 
mirroring the angel and making use 
of subtractive boolean operations to 
extract the missing geometry. The 
second method involves overlaying 
the undamaged angel relief on to the 
damaged relief and then making use of 
boolean operations to extract the missing 
geometry.

Both of these methods depended upon 
first generating a closed manifold mesh 
after scanning both of the reliefs however.

The missing geometry would then have 
to be manufactured using multi-axis 

CNC milling machines. This would 
require the generation of tooling paths 
and the accurate milling of the fracture 
surface. Realistically, if there was indeed 
rot present inside the wood then a 
section of the wood would have to be 
removed to create a clean surface for the 
new fragment to adhere to. This would 
be akin to using the Dutchman method 
except the missing component would be 
manufactured using digital fabrication 
technology instead of by a craftsman.

Additionally, there is a layer of thick 
white paint on the surface of both the 
reliefs. Ideally this would have to be 
removed before laser scanning can begin  
but since the structure is part of a listed 
building  this is not possible.

3D Scanning
Like the Belgian limestone column 
fragment, this site was also scanned using 
the Z+F Imager phase difference scanner. 

One of the challenges involved in laser 
scanning this particular case was getting 
close enough to the relief to get usable 
details in the scans. This was achieved 
by renting a ‘kamersteiger’ or indoor 
scaffolding to raise the laser scanner 
mounted on the tripod by 1.85 meters. 
The scaffolding was rented from a local 
hardware rental store called Boers and 
was transported in a Mercedes Sprinter 
van.

Before the scanning began, four reference 
spheres (two visible in the picture below) 
mounted on tripods were placed at 
regular intervals around the scan target. 
These spheres, like the printed reference 
targets used for the column, help orient 
the scanner in space and aid in stitching 
the point cloud together from multiple 
scans. The spheres would also help cancel 
out any micro-movements that could 
occur due to the shaking of the tripod 
and scaffolding due to wind and other 
external factors. A total of five 360 scans 
were performed on ‘normal quality’ and  
high resolution, taking a 3.5 minutes 
each.

Interestingly, since each scan instance 
covers a spherical 360 volume around 
the scanner, a large chunk of the 
Rotterdamseweg was also scanned 
including all adjacent buildings and 

persons standing around the scanner. 
This generated a relatively large point 
cloud file collection of 3.5 Gigabytes out 
of which the unnecessary data had to be 
cropped out.

Figure 192. Interpolation using the symmetricity 

of the relief. Source: Author

Figure 194. Impression of geometry to be 

manufactured.

Figure 193. Interpolation using the existing 

geometry from the undamaged relief. 

Reference Spheres

‘Kamersteiger’
rented from Boels
1.85 m

SP 1

SP 2

SP 4
SP 5

Figure 188. The Gateway to the Boerderij. Source: Unknown

Figure 189. Damaged Relief Figure 190. Intact Relief

Figure 191. Wood samples with evidence of rot Figure 195. The scan target and apparatus. Source: Author
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Figure 196. Figure 197. Figure 198. 

Figure 199. 

Figure 200 . 

Figure 201. Scanned Context

Figure 202. Scanned Context
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Imported Point 
Cloud

Damaged Angel 
Relief

(Target)

Triangulation using Poisson 
Surface Reconstruction

Intact Angel 
Relief

(Reference)

Imported Point 
Cloud

Triangulation using Poisson 
Surface Reconstruction

MESHING
The point cloud collection was imported 
into Autodesk Recap and were merged 
together. This revealed a mesh cloud 
of a large section of the street. The 
wooden angels (the objects of relevance) 
were then cropped and the point cloud 
exported in .pts format.

This second point cloud was imported 
into Meshlab and the standard meshing 
workflow was followed. The normals 
were computed from Filters > Point set 
> Compute normals for point set and 
then a Poisson mesh was generated from 
Filters > Remeshing, Simplification and 
Reconstruction > Surface Reconstruction 
Poisson.  The image below shows the 
properly realigned normals.

  

For the mesh calculation the Octree 
Depth was set at 10, the Solver Divide at 
7 and Samples per node at 15.

MANUFACTURING
Further research into the restoration of 
this candidate were suspended until the 
conclusion of the first test case.

Figure 203. Damaged relief scans and meshing

Figure 204. Intact relief scans and meshing

Restoration Matrix (Table 8)
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‘What are the influencing 
factors in the use and selection of 
LIDAR and Digital Fabrication 
for the patching of ornamental 
heritage?’

The aforementioned research questions 
can be answered by the aid of the follow-
ing sub-questions:

i. Is digital fabrication for patching 
applications more economical than 
traditional techniques?

Although a comparison was made with 
traditional techniques, the comparison 
was not very conclusive since the bulk 
of the costs for both new and old tech-
niques consists of labor costs. The only 
difference being manual labor versus 
digital labor. While the costs for tradi-
tional techniques were calculated to be 
higher than digital fabrication, this was 
mainly due to the higher labor costs used 
for a traditional stonemason in the Neth-
erlands, costs may be drastically lower in 
other parts of the world.

One fact stands out however, since the 
digital manipulation of meshes is not ge-
ographically constrained because of the 
nature of digital data, it is easier to find 
a lower bid from a global pool of talent 
rather than just a local pool. Despite 
this, current cost estimates do not give 
an accurate picture of the economy of 
digital fabrication since the technology 
is rapidly improving and possibilities of 
automation in the future might com-
pletely discount the role of the craftsman 
(for the patching of ornaments, not the 
production of new designs) except in 
special circumstances.

ii. What are the possibilities of hybrid-
ization of techniques (combination 
with traditional methods) for patch-
ing with Digital Fabrication?  

This issue was addressed after viable 
access to a multi-axis stone milling 
machine could not be established for 
the project. It was then decided to use 

molding and casting as a secondary 
workflow. The final fragment was then 
casted with cement inside a silicone 
mold.

This secondary method presented two 
disadvantages: the casted material 
would be different than the original and 
sharp edges in the fragment had to be 
smoothed out leaving a seam between 
the old and new materials. While both 
of these factors are not entirely ‘disad-
vantages’, the difference in materials and 
seam could be considered features of the 
restoration depending upon the inten-
tions of the restorer, they are however 
limitations. The casted material would 
not have the same strength as solid stone 
for example, and it may have varying 
thermal expansion or contraction rates. 
An advantage that the casting method 
provided however is that the mold could 
be reused, making it possible to create 
multiple prototypes for experimentation.   
Another advantage is the relatively lower 
cost of molding and the possibility of 
performing the entire process in-house 
without the use of expensive machinery 
(not including the laser scanner).

iii. Is the use of Digital Fabrication for 
patching advantageous for reversibili-
ty?

One of the more important factors for 
reversibility is a low level of interven-
tion in the initial restoration. With the 
aid of digital fabrication it is possible to 
recreate the entire fracture surface of the 
broken element and then manufacture 
only the missing fragments without the 
removal of any of the original material. 

This ensures that if a reversible binder is 
used, the intervention can be reversed to 
the original state. A similar ‘traditional’ 
(non-digital) method would involve the 
use of a stereo-pantograph (as being used 
in the restoration of the Parthenon) to 
recreate the fracture geometry but its 
use would be limited to simple fractures 
unlike the detailed geometry that laser 
scanning can provide. Therefore, digital 

fabrication has a significant role to play 
in increasing reversibility.

iv. In which instances is the use 
of Digital Fabrication warranted 
over Traditional Techniques for the 
patching of ornamental heritage?

While Digital Fabrication provides many 
advantages over traditional techniques, it  
requires a different skill-set, perhaps with 
a small overlap. It cannot be argued that  
it does not make sense to use Digital 
Fabrication for non-ornamental repairs 
since traditional methods provide far 
simpler and tested solutions. 

For ornamental repairs however, it can 
be easy to get blinded by technology and 
overuse it. In many cases, the damage to 
an ornament can be more than skin deep, 
rot in wood and cracks inside stone  are 
examples which require the trained eyes 
of restoration experts, material experts in 
particular, to be diagnosed. Any inter-
ventions without addressing these issues 
first can possibly exacerbate the damage.

The use of Digital Fabrication starts 
presenting advantages when traditional 
methods become too complex, when a 
higher degree of reversibility is required 
or when traditional techniques required 
to regenerate a certain type of geometry 
have been lost or are not available.

v. What is the role of the craftsman in 
Digital Manipulation and Digital Fab-
rication? (Subjective)

In this context, a difference between 
a  craftsman and operator has to be es-
tablished. An operator simply follows a 
set of instructions without any input of 
their own and his or her skills may not 
improve over the course of time since the 
final quality would be dependent upon 
the machines being used. 

It is true that the processes followed in 
this project required some ‘operator-like’ 
functions, laser-scanning for instance 
requires the pressing of a few buttons and 
the scanner does the rest (not discounting 

11. CONCLUSIONS
Answers to Research Questions

the skill of the operator since operating 
complex machinery requires extensive 
training) if all instructions are carefully 
followed. There were instances however, 
when direct manipulation of geometry 
was required, during the sculpting of the 
mesh in Geomagic Freeform for example. 
This kind of manipulation required a 
certain degree of dexterity, that can only 
be improved over time. With the use 
of haptic feedback interfacing devices, 
the process becomes quite similar to 
how a traditional craftsman interacts 
with material, adding legitimacy to 
the comparison and the term ‘neo-
craftsman’.

vi. What are the primary limiting 
factors when patching using Digital 
Fabrication and LIDAR technologies 
as they are today?

From the experimentation it was 
determined that while current 
technology is advanced enough to enable 
the manufacturing of considerably 
complex geometries, material variation 
remains the primary limiting factor, 
this was also confirmed by the various 
experts that were interviewed. While  
subtractive manufacturing technologies 
like multi-axis CNC milling can provide 
high detail results in a large variety of 
materials, additive manufacturing tech-
nologies have some way to go before the 
most advanced techniques can become 
mainstream. 

Subtractive manufacturing technolo-
gies have two main disadvantages, they 
produce waste material and require the 
use of heavy machinery under constant 
supervision. While these factors did not 
influence the decision to use additive 
manufacturing for the production, they 
can play a role depending upon the 
nature and scale of the project.

One limitation that envelopes all the 
discussed technologies is the scale of 
the ornament being repaired. Every 
selected technology presents its own 
scale limitation, multi-axis CNC milling 
machines have a maximum reach while 
3D printers have a maximum build 
volume. These constraints however 
can be overcome by manufacturing the 

pattern in pieces or in the cases when the 
original material is being used, manually 
finishing the end result.

One of the reasons that the production 
of the patching sample was hybridized 
via the use of silicone molds was 
that even if multi-axis stone milling 
machinery was directly available for 
research, production of multiple samples 
would require heavy investment of time 
and resources while the alternative only 
required the use of domestic 3D printers 
and silicone molding techniques, with 
the added advantage that the molds were 
reusable. 

During the scanning, the laser 
scanning apparatus also presented some 
limitations, namely the large size of the 
apparatus making mobility difficult, the 
inclusion of noise in the scans, and the 
inability to scan hidden geometry. The 
former limitation was most apparent 
during the scanning of the Boerderij 
Hammenwoning, which required the 
use of scaffolding and tripods to reach 
the required height. The size of the 
scanner became a limitation as it would 
sway with the wind. 

The noise however, which is derived 
from the errors in the digital processes 
that occur during scanning, as well as   
environmental factors also proved to be 
a limitation factor. While the noise could 
be controlled during the meshing process 
as well as by the removal of isolated 
or extraneous data, these processes 
resulted in lose of high frequency detail, 
essentially the loss of data.  

Although not a limitation of the 
technology, the inability to scan hidden 
geometry obstructed by other features 
on the ornament or hidden in cavities 
should be taken into consideration before 
scanning. These hidden geometries 
can possibly be manually measured 
and inserted into the point cloud post-
scanning.

While these limitations affected the 
results of the project, they were not 
significant enough to disrupt the entire 
process. These limitations can possibly 
be minimized as the technology develops 
further.

vii. What kind of role does software 
play in the patching via digital 
fabrication process?

It became apparent quite early in the 
project that software selection played an 
important role in the correct manipula-
tion and quality of the final mesh. 

Starting from the generation of the 
mesh from the point clouds, various 
software packages were selected until 
an optimum result was achieved using 
CloudCompare. As mentioned in the 
text, the optimum software package 
may vary from geometry to geometry, 
some packages are better at interpolating 
meshing with sparse point clouds while 
other are better at memory management 
which aids in the generation of complex 
meshes.

For the manipulation and editing of 
meshes, the software selection played 
an important part. One of the primary 
geometric operations that were required 
for this project was the Boolean 
operation. There are several different 
algorithms that perform such operations  
using slightly different methods and 
different software packages may make use 
of different types of algorithms to achieve 
the same result. Autodesk 3D Studio 
Max for example is packaged with two 
different types of Boolean operations, 
the ‘Boolean Compound Object’ and 
the ‘ProBoolean Compound Object’, 
both perform the same function but use 
different methods. After experimentation 
with the boolean operations in various 
software packages like 3D Studio Max, 
Rhino3D and Geomagic Wrap, it was 
determined that the most usable results 
were obtained from Geomagic Wrap (3ds 
Max failed during complex calculations 
while Rhino3D provided usable results 
but after decimation) with minimal loss 
in geometry. One of the reasons for this 
could be that while all three are mesh 
editing packages, Geomagic Wrap is 
optimized for laser scanned data and also 
provides tools for noise reduction and 
cleaning of meshes. 

It can be deduced from the 
aforementioned that the selection of 
software packages is an important factor  
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in the process of digital manipulation 
and carries as much weight as all the 
other tools, hardware or otherwise, 
available to the ‘neo-craftsman’.

Conclusion

In summation, the use of Digital 
Fabrication is context dependent and 
not universal. 

On many occasions it may be a necessity 
to use Digital Fabrication as an aid to 
the restoration process in conjunction 
with other techniques rather than as the 
primary technique. It has to be noted 
that on its own, Digital Fabrication is 
not an effective tool for the patching 
of geometry, it has to be used in 
conjunction with other technologies like 
laser scanning (LIDAR) or photogram-
metry.

It also has to be evaluated whether the 
damage to an ornament is more than 
skin deep and whether the use of Digital 
Fabrication can exacerbate the existing 
damage (see sub-question iv).

Factors that influence the selection of 
Digital Fabrication technology can 
include the complexity of the geometry 
of the ornament (which can determine 
whether the use of DF is required or 
not or which technology would be 
more applicable), the material of the 
ornament, whether reversibility is a 
priority, whether the available traditional 
techniques are better alternatives, if 
authenticity is a priority or whether 
applicable traditional techniques have 
been lost. 

Once a technology has been selected, 
there can be various parameters that 
affect the end result. These include the 
level of noise in the scans, the flexibility 
provided by the selected software 
packages, the resolution of the selected 
manufacturing technology, whether 
there is hybridization with other tech-
nologies and the scale of the fragment to 
be manufactured.

One factor that does not play a very 
significant role however is economics, 
since a majority of the cost of such res-
torations comes down to labor costs and  

both traditional and new techniques 
require the use of labor in one form or 
another.
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